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ABOUT THIS DOCUMENT 

• This Handout is intended to be used in conjunction with the RootsMagic Online Help, accessible 

from within the RootsMagic program using the F1 key from anywhere in the program, from the 

HOME Page and/or by selecting Help in the Options Menu found in the upper right corner of the 

Program Window.  

• This Handout is the official repository for the supplemental information and personal 

recommendations I’ve provided at monthly GFO RootsMagic SIG meetings and is provided as a 

reference for GFO SIG members.  

• I don’t currently, and may never, use all of the features discussed in our SIG meetings in my personal 

family research database. The purpose of this Handout is to supplement the information found in 

the RootsMagic Online Help to make GFO SIG Members aware of ALL RootsMagic features and how 

they can be used, along with any undocumented limitations.  

• Recognizing one of the GFO RootsMagic’s SIG’s Operating Principles: “There is no single, correct, 

way to do genealogy;” the evaluation of each feature’s usefulness and the decision to utilize it as 

part of each GFO SIG Member’s individual quest to do family research, is left to each SIG Member, 

given their specific use case. 

• There may be errors in this Handout and some information may conflict with how each SIG Member 

has decided to use RootsMagic. Therefore, use of the information in this Handout is at your own 

risk.  

• This is a living document that is periodically updated as new topics are discussed in the monthly SIG 

meetings, the software changes, the Online Help changes and/or new information about how the 

existing version of the program works (or doesn’t). Since this is intended to be a supplement, very 

little information found in the Online Help is repeated in this Handout.  

• When information included in this document is incorporated in the Online Help, it will be deleted 

from this Handout. Currently, this document covers information for RootsMagic versions 9 & On. 

• The latest version of this document can be found at the GFO RootsMagic SIG webpage  

Barry Wolff 

GFO RootsMagic SIG Facilitator 

RootsMagic@gfo.org 

  

https://gfo.org/learn/special-interest-groups/rootsmagic.html
mailto:RootsMagic@gfo.org
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This Table of Contents is a combination of the contents of the latest RootsMagic Online Help and the supplemental 

information contained in this Handout.  

• The black entries identify sections and subsections found in the Online Help. The red entries identify Handout 

subsections not found in the Online Help.  

• Clicking on the primary section headings will open the webpage for the corresponding section of the Online 
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• Clicking on the Page numbers will take you to the corresponding supplemental information in this Handout.  
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Online Help yet 
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that topic in the Handout and you should refer to the corresponding Online Help subsection webpage 
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GETTING STARTED  

GENERAL INFORMATION  

1. RootsMagic doesn’t provide telephone support. Any information you find online about phone 

support is a scam 

2. RootsMagic Help is available via several means; all of these are accessible from the HOME Page: 

a. Online Help: 

i. The F1 Key opens the Online Help based on where you are in the program 

ii. The Table of Contents of this Handout contains links to each primary section in the 

Online Help in addition to links to supplemental information in this Handout 

b. Technical Support  

i. Online Chat (M-F during normal work hours, Mountain time) 

ii. Online Help Request submittal 

c. RootsMagic Online Community 

3. Help is also available via: 

a. The private FaceBook Group: “RootsMagic Users”, administered by RootsMagic 

b. The GFO RootsMagic SIG meetings and email ( rootsmagic@gfo.org  ) 

4. The following general data entry and navigation guidelines apply to many different areas in 

RootsMagic: 

a. Whenever an “arrow” (greater than, less than, up and/or down symbol) is displayed, it’s 

indicating the ability to: 

i. On all sub-menu bars, the “left arrow” is used to navigate “back” to the previous 

screen  

ii. Data fields that display data and have a “right arrow” at the far right, can be navigated 

by clicking anywhere in the data field to access the next screen of data or options 

iii. On PEOPLE Page > PEOPLE Views: You must click on the “arrow” to shift the data 

displayed up or down by one generation 

iv. On PEOPLE Page > SIDEBAR > (RM11 & On) LIFE SUMMARY/(RM9 & 10) FAMILY and 

BOOKMARKS Views: You must click on the “arrow” on the far right in order to change 

the PEOPLE View to the selected Person 

v. RM 9 & 10, On PEOPLE Page > SIDEBAR > INFO View: On the PARENTS and SPOUSES 

Tabs, you can click anywhere in the “Children” row displaying the “right arrow” at the 

far right to display a list of their children 

vi. On a Person’s EDIT PERSON Window: On the PARENTS and SPOUSE rows, you must 

click on the “down arrow” to view the list of People in the Family that you can switch 

to without leaving the EDIT PERSON Window 

b. Whenever “number” data fields with a slider input are displayed: 

i. Numbers can be set by moving the slider 

ii. Or, numbers can be directly entered by clicking the number data field and entering it 

c. Some data fields without “arrows,” when clicked on, display a pre-defined list of choices or 

tool icons may appear on the far right that will open relevant tools that can assist in deciding 

what to enter in the data field 

mailto:rootsmagic@gfo.org
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5. If you’re new to RootsMagic, in addition to the Online Help, you may find the “Getting Started 

with RootsMagic 11” YouTube video produced by RootsMagic helpful in learning the basics and 

newest features: 

6. If the RootsMagic program appears to “freeze” and nothing appears to work for some reason, 

but other programs continue to work as normal on the computer, do the following: 

a. First, check to see if a Popup window is hidden behind the main Program Window: 

i. Click on the RootsMagic program icon in the Windows Task Bar (Dock icon on a Mac). 

The currently active RootsMagic Window will be brought to the front 

b. If there wasn’t a hidden window causing the program to “freeze,” terminate the RootsMagic 

program, which can be done as follows: 

i. For Window PCs: 

1. Press Ctrl, Alt & Delete keys at the same time 

2. Select Task Manager 

3. On the Processes Tab, locate the program and select it 

4. At the bottom right, click on “End Task” to terminate the program 

5. Close Task Manger 

6. Restart RootsMagic 

ii. For Macs: 

1. Press Option, Command & Escape at the same time to open Force Quit, or select it 

from the menu 

2. Locate the program and select it 

3. Force Quit the program 

4. Close Force Quit 

5. Restart RootsMagic 

7. RootsMagic database files must be opened from within the program. Database files will not 

open by double-clicking on them.  

a.  

8. When any type of error message is encountered while using RootsMagic, shut down RootsMagic 

and restart the program. Proceeding without restarting the program risks the possibility of 

database corruption of follow-on work 

9. If a RootsMagic database file is moved between Mac and Windows computers, the first thing 

that should be done after opening the file is to run the TOOLS > DATABASE TOOLS > REBUILD 

INDEXES tool  

https://www.youtube.com/watch?v=9yHB34MVlWo
https://www.youtube.com/watch?v=9yHB34MVlWo
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THE ROOTSMAGIC INTERFACE  

PEOPLE PAGE  

1. Searching from the PEOPLE Page > SIDEBAR > INDEX View and/or PEOPLE Page PEOPLE List 

View: 

a. General search format is: “Surname, Given Name” 

b. Anything entered prior to the comma is considered a “Surname” search phrase and anything 

entered after the comma is considered a “Given Name” search phrase 

c. Partial Name text can be entered, and the text does not have to start with the first letter of 

the Name 

d. Given Names can be searched without entering anything prior to the comma 

e. The search will commence as characters are entered in the Search Box. The results refine as 

additional search text is entered 

f. Wildcard characters can be used in PEOPLE Page Searches: 

i. Single character wildcard = “_” 

ii. Any number of characters, including none, wildcard = “%” 

iii. These wildcard characters also work when searching other lists in RootsMagic, such as 

Places, Sources and Fact Types  

g. If a Surname search is prefaced with a double quote (“), search results will only include 

surnames that start with the text entered. This special character does not work for Given 

Name searches (text entered after a comma). 

h. Searches on the Couple List View: 

i. Results include Married Surnames   

ii. RM10 & On, You can search for either, or both, Father and Mother names by using an 

ampersand (&). Anything entered before the symbol is applied to the first column 

(Father) and anything entered after is applied to the 2nd column (Mother).  

i. If known, you can also enter the complete RIN (Record ID Number) for a specific Person. 

2. PEOPLE LIST View: 

a. When customizing the number of columns to show; the maximum number that can be 

added is 42. Adding a 43rd column will cause the program to crash and the database file will 

be corrupted and can only be recovered by restoring a Backup File 

3. ASSOCIATION View:  

a. Associations allow you to define a Non-Family relationship between 2 People in a database 

i. Both People must be entered in the database file 

ii. Unlike Facts, Associations can’t be shared with other People; nor can they be copied or 

moved 

iii. There are 16 built-in Association Types, which can’t be deleted. You can’t edit the 

Association name or the names of Role 1 & Role 2 for the built-in Association Types. 

iv. RM10 & On, Associations can be transferred to another file via Drag & Drop, if both 

People are selected. Otherwise, the Association is dropped, similar to Family/Couple 

Facts when the Spouse is not selected 

b. Creating an Association between two People in separate trees within the database file DOES 

NOT “connect” the trees together into a single tree.  
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i. They remain treated as separate trees when using the “Count Trees” tool or selecting 

“Everyone in a tree” while performing a Drag & Drop, Color Coding, Advanced Searches 

or defining Group Rules 

ii. The only way to “connect” separate trees is by adding Parent/Child or Spousal Family 

links to define the family tree relationship 

c. Adding an Association: 

i. There are five ways to add an Association to a Person: 

(1) Click on ADD to add a Fact, and then select “Association” 

(2) Hover over a Person, right click and select “Add Association” 

(3) Open the COMMAND PALETTE and select “Add Association” 

(4) From the Person’s EDIT PERSON Window: 

(a) Click on the +(Add) icon to add a Fact, then select “Association” 

(b) Hover over the Fact list area, right-click and select “Add New Fact”, then select 

“Association” 

ii. Then select the Association Type and fill in the rest of the data fields 

iii. Data entered in the Note field will be appended to both People’s sentences, if Notes 

are included in the Report Settings 

d. Editing an Association: 

i. An existing Association can be edited from either a Person’s open EDIT PERSON 

Window, or from the PEOPLE Page > ASSOCIATIONS View: 

(1) From the EDIT PERSON Window, select the Association and edit it. Edits affecting 

the Narrative Sentence will be shown in the Sentence area 

(2) From the ASSOCIATIONS View, you can: 

(a) Select and open either, or both, EDIT PERSON Windows by clicking on the 

corresponding EDIT Button. Then make edits as described above 

(b) Clicking on the EDIT RELATIONSHIP Button should be avoided. It opens the EDIT 

ASSOCIATIONS Window: 

(i) There’s no advantage to using this Button. All Association data can be 

edited from either Person’s EDIT PERSON Window. 

(ii) There are significant limitations:  

1. You can’t see the impact of edits reflected in the resulting Narrative 

Sentences.  

2. Plus, you can’t navigate anywhere else while this Window is open 

e. Association Sentence Templates can’t be customized for individual Associations 

f. To view each Associate’s resulting sentence generated from their Role’s Sentence Template, 

you must view the Association from each Person’s EDIT PERSON Window 

g. Association Types: 

i. Association Types can be created, edited and deleted in a manner similar to Fact Types 

by opening the Association Type List. 

ii. The decision to modify an existing Association Type vs creating a new one follows the 

same decision process outlined for Fact Types 

iii. Unlike Fact Types, there aren’t individual Association Type settings to select which 

outputs to include them in. Instead, the inclusion of all or none is made as part of 

defining the settings for the selected type of output being generated  
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SEARCH PAGE 

1. The Columns of information shown in the BASIC SEARCH and ADVNACED SEARCH Views can be 

customized: 

a. The maximum number that can be added is 42. Adding a 43rd column will cause the 

program to crash and corrupt the database file. Once corrupted, the file can only be 

recovered by restoring a Backup File 

b. RM9 & 10, The columns of information shown in the PERSON SEARCH and PERSON SEARCH - 

ADVANCED search results are the same ones selected when the PEOPLE LIST View is 

Customized on the PEOPLE Page 

2. BASIC SEARCH View:  

a. Partial names can be entered, and it does not have to start with the first letter 

b. Wildcards and the double quote (“) character DO NOT work for name searches 

3. ADVANCED SEARCH View: 

a. Some have reported that RootsMagic is “slow” after performing an ADVANCED Search as 

long as the filtered results are present in the RESULTS area of the SEARCH Page. It’s 

recommended that once finished working with the results, click on the CLEAR RESULTS 

Button. 

b. Wildcards and the double quote (“) character DO NOT work for name searches 

c. Search Rules: 

i. RM9 & 10, The following table contains all the data fields that can be used for 

ADVANCED SEARCHES based on Criteria and all other functions (like ROOTSMAGIC 

EXPLORER Mark/Unmark “By Data Fields”) that utilize the Boolean Logic/Criteria Filter 

Window:  

Each Fact in the database  Number of children 

Any Fact Number of sets of parents 

Association  RM10 & On, Number of shared facts 

Color Coding  Number of siblings 

Current Age  Number of spouses 

Date Edited  Prefix 

FamilySearch ID  Record number 

Given name(s)  Sex 

Given or Nickname  Source (family) 

Living flag  Source (general) 

Married Surname  Suffix 

Nickname Surname 

Note (family)  Surname (Birth or Marr) 

Note (general)  

 

ii. Be aware that searches using the “Date Edited” attribute are based on the Date that is 

displayed in the lower left of the EDIT PERSON Window. There are many changes to 

data linked to the Person that do not cause the Person’s “Date Edited” date to be 

updated  

iii. RM11 & On, Enhanced Rules-Based Searches: 
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(1) This RootsMagic video demonstrates how to use it: “Better Search in RootsMagic 

11 (Search Enhancements)”  

(2) Associations can be searched based on specific Association Types 

iv. RM10, Rules-Based Searches: 

(1) This RootsMagic blog article provides an example of how to use it: “Memorial Day 

Preparation: Finding My Ancestors One Cemetery at a Time”  

(2) RM9 & 10, Associations can’t be searched or filtered based on specific Association 

Types, only the presence of an Association can be determined.  

v. RM10, A handy application of the Saved Search feature combined with a Rules-Based 

Group can be set up as follows:  

Note: (RM11 & On) This handy application is not necessary since the ability to 

create a Group directly from an ADVANCED Search exists 

(1) Decide on a common name to use for both the Saved Search and Group. Consider 

assigning a simple name that starts with a special character that cause them to sort 

to the top of the Saved Searches and Group Listings  

(2) From the PEOPLE Page, create a Rules-Based Group, with one Criteria set to: 

“Unselect Everyone In File”  

(3) From the SEARCH Page > PERSON SEARCH - ADVANCED, create a Saved Search with 

one Rule: “Group - Select a Group of People” and set it to the Group just created  

(4) This can now be used to:  

(a) Manually add People to the Group, like People listed on a Census  

(b) Use the “Saved Searches” option found under the MARK/UNMARK Buttons on 

the ROOTSMAGIC EXPLORER Window to select the People defined in the 

associated Group  

(c) Perform the operation that opened the ROOTSMAGIC EXPLORER Window to 

MARK/UNMARK the desired People, like: “Copy Selected Fact”  

(d) After completing the operation involving that set of People, “Refreshing” the 

Group, will “Unselect” everyone that had been manually added to the Group.  

(e) The Group is then ready for the next set of People to be manually added in 

support of the next operation 

4. WEBSEARCH View: 

a. The list of People in the database can be searched, similar to the PEOPLE Page > SIDEBAR > 

INDEX View, using the format of: Surname, comma, First Name. 

b. Partial names can be used too 

c. Wildcards and the double quote (“) character work for name searches 

d. RM11 & On, The EDIT Button opens the EDIT PERSON Window of the Person selected in the 

lower list of People, which may not be the Person the WebSearch was performed on, if the 

data was pre-loaded with the currently selected Person on the PEOPLE Page 

5. FIND EVERYWHERE View: 

a. When searching for an item that may appear multiple times, possibly in different areas of 

the database, the hyperlink in the search results will open the location where the data 

resides so it can be edited. Any edits will be reflected everywhere that the data is used. To 

https://www.youtube.com/watch?v=93Bv_F15fx0
http://blog.rootsmagic.com/?p=3820
http://blog.rootsmagic.com/?p=3820
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see where the data is being used, view the list of links by clicking on the Used field for the 

item.  

TOOLS PAGE 

1. For each tool with a red “Important” Warning, you should perform a database Backup prior to 

using the tool in case the results are not as expected. 

2. FACT TOOLS: 

a. When using the “Change Fact Type for Everyone” tool: 

i. I recommend first checking all of the Fact Type Property settings, including the Sentence 

Template, for both the “before” and “after” Fact Types 

(1) Data entered in data fields not active in the “new” Fact Type is still in the database, 

just not displayed  

(2) Data fields not active in the “old” Fact Type that are active in the “new” Fact Type 

will be blank until populated 

ii. Any Property setting differences may require follow-on cleanup work in every affected 

Fact and/or the Fact Type Sentence Template after changing Fact Types.  

(1) If this a possibility, consider creating a Group containing everyone with the original 

Fact Type prior to changing it.  

(2) This would become a “To-Do list” of People to review after changing to the new Fact 

Type to make sure all newly active data fields contain the needed information 

SETTINGS PAGE 

1. The SETTINGS Views: 

a. Program-Level settings are set in:  PROGRAM, FOLDERS, & DISPLAY Settings Views 

b. File-Level settings are set in:  GENERAL, PREPARER, WEBHINT and LDS Settings Views 

c. The following are my recommendations for key Settings on each of the SETTINGS Page. 

2. PROGRAM Settings View: 

a. Ask for Backup when exiting RootsMagic – YES 

b. Add date to Backup – YES 

c. Check for duplicates when adding People – YES 

d. County Check – YES (unless you’ve decided to always use Current Day locations) 

e. Date entry – USE SYSTEM SETTINGS 

3. FOLDERS Settings View: 

a. Data Folder – This location should be set prior to using TreeShare with Ancestry or Restoring 

a Backup. This will enable RootsMagic to use “relative” paths for Media Files placed in the 

resulting Media Folders when performing these activities. Otherwise, RootsMagic will store 

“discrete” paths for Media File links. 

b. Backup Folder – Set to its own folder location to keep Backup Files separate from all other 

file types 

c. Media Folder – Starting with RootsMagic 8, Media Files are linked using “relative” paths 

from several locations (despite displaying full path names, including drive letter, to the User; 

implying all links are “discrete”).  

i. All Media Files added after a Media Folder location is specified in the SETTINGS Page > 

FOLDERS Settings View will be “relative” to the Media Folder location, if the Media File 
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is located in the folder or a subfolder. Therefore, it’s recommended that the Media 

Folder specified should be the “top level” folder where most/all Media Files being 

added are located, or in sub-folders. Ideally, the Media Folder location should be 

specified prior to linking any Media Files to information in the RootsMagic database 

file. 

ii. Changing the Media Folder location after already having linked Media Files may result 

in broken links that must be fixed after the change using the “Fix Broken Links” tool 

(TOOLS Page). 

d. Help Folder – Leave blank to ensure you always view the latest Help information available 

online unless you have a unique circumstance where internet access is limited. 

4. GENERAL Settings View: 

a. Database Color – Recommend selecting a different color for each database file/groups of 

files, especially if work is done with more than 1 open at a time.  

i. Reminder: You must switch Pages to reflect the newly selected color. 

b. Problem Alerts – YES 

c. Problem Options – Review to make sure they meet your expectations for Alerts 

5. DISPLAY Settings View: 

a. Font scaling – You must restart RootsMagic to ensure all fonts are set to the new settings. 

Also, take note of the current setting prior to making a change so that it can be reset if the 

new setting isn’t desired 

6. PREPARER Settings View:  

a. Name, Address, Phone and E-Mail are the only entries that will be included in reports when 

Preparer Data is selected to be included. Cell, Fax and Website entries are not used in 

reports. If any of this excluded information is desired to be included as report Preparer Data, 

the information will need to be added to one of the data fields that is included. 

7. WEBHINT Settings View: 

a. Ancestry: 

i. For Ancestry WebHints to work, you must be logged in and the file linked to an 

Ancestry tree via RootsMagic Treeshare 

ii. The “Clear on Accept” setting controls how TreeShare works, not WebHints.  

(1) When selected, and the “Only Show Changed People” checkbox is selected in the 

TreeShare Window, after the highlighted Person’s changes are accepted in 

TreeShare, the Person is removed from the list of People displayed and the new 

highlighted Person becomes the first Person in the list 

(2) It’s recommended that this combination of settings only be used when working the 

TreeShare list from top to bottom to avoid having to scroll through the list to find 

the next Person after each set of changes are accepted.  

iii. Warning: DO NOT select “Disconnect from Ancestry Tree” unless it’s desired to 

permanently sever the Treeshare link between the Ancestry Tree and the database file. 

THIS ACTION CAN’T BE UNDONE.  

(1) If done in error, a recent Backup File from when Treeshare was still connected to 

the Ancestry tree must be Restored, or a new Treeshare connection must be 

created with either a new Ancestry Tree or a new RootsMagic file. An existing 

Ancestry Tree can’t be “re-connected” to an existing RootsMagic file 
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iv. Rather than “Disconnect from Ancestry Tree”, use the “Reset Treeshare” function to 

force RootsMagic to rebuild the TreeShare links between the connected Ancestry Tree 

and database file. 

b. FamilySearch: 

i. For FamilySearch WebHints to work, you must be logged into FamilySearch  

ii. FamilySearch WebHints are only provided for People that have been Matched to their 

corresponding Person in the FamilySearch Family Tree  

c. FindMyPast: 

i. Evaluating and dispositioning FindMyPast WebHints is a completely manual process 

performed external to RootsMagic. Data from any Confirmed WebHints must be 

manually entered into RootsMagic. 

 

d. MyHeritage: 

i. Evaluating and dispositioning MyHeritage WebHints is a completely manual process 

performed external to RootsMagic. Data from any Confirmed WebHints must be 

manually entered into RootsMagic. 

8. LDS Settings View:  

a. No recommendations 
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DATABASES  

GENERAL INFORMATION:  

1. The database engine used by RootsMagic is SQLite ( www.sqlite.org ). SQLite does not support 

multiple users. Therefore, it’s important to only have one computer, with one computer 

program, accessing the database file at a time 

2. Warning: Tech Support recommends not using ANY file syncing/sharing programs (i.e. 

Onedrive, Dropbox, Google Drive) with database files as they can cause database access 

errors. The worst-case scenario is the possibility they can corrupt the database file, making it 

unrecoverable. This recommendation is just for the database file itself and does not apply to 

Media, Backups, or any other type of file that RootsMagic uses/creates. They are aware of 

situations where People have used file syncing/sharing for extended periods of time with no 

issues; and then one day their database file becomes corrupted and is unrecoverable.  

3. When strange things occur that may be the result of a corrupted database file, the following 2 

steps should be tried to see if either will fix the issue: 

a. Run all of the Database Tools prior to reaching out for help:  

i. FILE Page > TOOLS (also found on TOOLS Page); then perform each of the Database 

Tools (Test Integrity, Rebuild Indexes, Clean Phantom Records and Compact), the order 

is not important. 

b. If running the database tools does not fix the issue, the next step is to Drag & Drop the 

entire database contents into a new, empty, file. Don’t delete the original file because it 

may be needed as a reference to manually migrate data that did not transfer (see Databases 

> Dragging and Dropping People) 

c. If Drag & Drop doesn’t resolve the issue, the only other option is to Restore the last Backup 

File that doesn’t demonstrate the symptoms being experienced 

4. File extensions: 

a. ADP & ADP-journal– Interim files created by RootsMagic when the TreeShare Window is 

open. These files are normally deleted by the program when the TreeShare Window is 

closed. They’re left behind when RootsMagic encounters a problem or the process is 

cancelled while the TreeShare Window is open. These file types can be deleted.  

b. csv – Comma-Separated Values file (PUBLISH output format) 

c. docx – Microsoft Word file (PUBLISH Page output format) 

d. DUP & DUP-journal – Interim files created by RootsMagic when identifying duplicate entries 

and/or file compare. These files are normally deleted by the program when complete. 

They’re left behind when RootsMagic encounters a problem or the process was cancelled. 

These file types can be deleted 

e. ged – GEDCOM File (used to transfer data between genealogy sites/software) 

f. lst – RootsMagic list file (text file created when a GEDCOM File is imported into RootsMagic. 

It will list any issues encountered during the import process) 

g. pdf – Adobe portable document format file (PUBLISH Page output format) 

h. rmbackup – RM8 & On Backup File (compressed .zip File) 

i. rmgb – RM7 Backup File (compressed .zip File) 

j. rmgc – RM7 database file (also RM8 & On files exported to Dropbox for use by RootsMagic 

IOS App) 

http://www.sqlite.org/
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k. rmtree – RM8 & On database file 

l. rmtree-journal – Interim journal file created by RootsMagic. File is normally created & 

quickly deleted multiple times while performing tasks that require progressing through a lot 

of data in the file, such as TreeShare and building Thumbnail images. If left behind due to a 

task not running to completion, it may prevent follow-on RootsMagic tasks from running 

error free. This file type should be deleted. 

m. rmst – RootsMagic Custom Source Template file (Custom Source templates can be 

imported/exported from the Source Template List Window)  

n. svg – Scalable vector graphic file ((PUBLISH Page output format) 

o. txt – Text file (PUBLISH Page output format) 

p. xlsx – Microsoft Excel file (PUBLISH Page output format) 

5. A database file deleted from within RootsMagic IS NOT placed in the Recycle Bin/Trash Can, it 

just permanently disappears.  

a. Before deleting, archive (using the Backup function, with media if desired) a copy if you 

might want to resurrect/use the file in the future. 

CREATING A NEW DATABASE: 

1. Before creating the 1st new RootsMagic file in the program, my recommendation is to first go to 

SETTINGS Page > FOLDERS Settings View and specify at least the Data and Media Folder 

locations because these are used by RootsMagic to determine whether “relative” or “discrete” 

path locations will be placed in the database to identify link paths to the database file and Media 

Files added later.  

2. Create New, Empty, File: 

a. After creating a new file, do the following: 

i. Go to the SETTINGS Page and review all the File specific settings in the GENERAL, 

PREPARER, WEBHINTS & LDS Settings Views 

3. Create New File by Importing Data or Downloading from an Online Tree: 

a. If importing data from a GEDCOM File exported from a RootsMagic file to create a new file, 

all limitations and cautions regarding using GEDCOM to exchange RootsMagic data ( see 

Databases > Importing Data) apply. 

b. Importing data from post-2014 Family Tree Maker (FTM) software files to RootsMagic can’t 

be done directly due to FTM’s proprietary file format. RootsMagic Tech Support 

recommends trying all of the following and evaluate which process works best with your 

specific set of data: 

i. Sync FTM data to an Ancestry Tree and then download Ancestry Tree data (including 

media) to RootsMagic via Treeshare function 

ii. Export FTM data to a GEDCOM File and import into RootsMagic 

iii. Export FTM data to FTM v2014.0 or earlier and import into RootsMagic (Per Tech 

Support, the RM7 import FTM 2014 tool works better than the RM8 & On FTM 2014 

import tool, this will be fixed in a future update) 

iv. The results of the above options are evaluated, in addition to looking at the “File 

Properties” and “Enhanced Properties” on the HOME Page, you may want to use the 

FILE Page > TOOLS > COMPARE tool to help identify differences between the imported 

files. 
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c. Direct import of Legacy software files and pre-2008 FTM files to RootsMagic can only be 

accomplished using the 32-bit version of RootsMagic installed on a Windows PC (Pre-RM9 is 

only available in 32-bit, but RM9 & On are available in both 32- & 64-bit Windows versions). 

A direct import will have better results than using a GEDCOM File due to the improved 

mapping of data types used in the import tool. 

d. After creating a new file by importing data or downloading from an Online Tree, do the 

following 

i. Go to the HOME Page and review the “File Properties” to confirm what was imported is 

what was expected 

ii. Just like creating a new, empty file, go to the SETTINGS Page and review all the File 

specific settings in the GENERAL, PREPARER, WEBHINTS & LDS Settings Views 

iii. Be aware that imported/downloaded data may result in: 

(1) New Custom Facts being created for Fact Types that don’t match existing 

RootsMagic Fact Types 

(2) Sources and Citations created using the Free Form Template, rather than any 

preferred Source Template type 

(3) Place Names and Place Details that do not conform to your naming and/or 

structure conventions. 

iv. Depending on the intended use of the new file, the imported/downloaded information 

may need to be cleaned up to meet your standards/conventions. 

e. Consider “Archiving” a copy of the original file that was imported and a copy of the file after 

it was imported for future reference in case it’s needed in the future to determine whether 

some erroneous information originated in the original imported data, or was added later. It 

can also help to figure out if data was “dropped” during the import process because 

RootsMagic couldn’t determine what the data was and it wasn’t noticed that data was 

missing until later. 

OPENING AN EXISTING DATABASE: 

1. The “Recent Files” section lists up to the last 8 files opened 

2. The “Found Files” section only lists files found in the folder and subfolders specified in the 

SETTINGS Page > FOLDERS Settings View for the “Data Folder” and the common Operating 

System folder and subfolder locations for documents (i.e. Documents folder in Windows). The 

list will contain RM8 & On (.rmtree) and RM7 (rmgc) files in these locations.  

a. If looking for a “missing file” it’s best to use the Operating System File Explorer/Search 

utilities and wildcard characters to try to locate where the file is located 
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WORKING WITH MULTIPLE DATABASES 

1. Up to 4 different files can be open at the same time (only 1 in the free version). 

a. If you want to view information for different parts of the database at the same time, other 

than viewing individual EDIT PERSON Windows; you must make a “Reference” Copy of the 

database file and assign a different name to it. Make sure you only make changes in the 

“Master” File, not the “Reference” Copy. I recommend also giving the “Reference” Copy a 

unique “Database Color” that reminds you that it’s not the “Master” File for making changes 

(SETTINGS Page > GENERAL Settings View). 

2. If you have RootsMagic set to open the last file used (SETTINGS Page > PROGRAM Settings 

View), when working with multiple databases, close the database you want to use next time, 

last. 

3. The 1st file opened behaves a little different compared to the 2nd to 4th files: 

a. When the 1st file is minimized, all open File Windows are minimized 

b. As long as the 1st file is not minimized, the 2nd to 4th files can be minimized and they are 

placed in the lower left of the desktop 

c. If you close the 1st file before all the other open files, the behavior of the 1st open file 

transfers to the next file opened in the session that is still open 

d. Currently, there are a few Popup Windows that appear centered in the 1st File Window, 

even if you’re working in the 2nd to 4th file.  Therefore, it’s advised to NOT position the 1st 

File Window so that the center of the Window is not in the visible Desktop area. If you do, 

the Program appears to “freeze” because you can’t see/click the buttons on the Popup 

Window, requiring you to terminate RootsMagic via the Operating System. 

e. Popups I’ve identified (so far) that center on the 1st File Window are: 

i. The Spouse selection Popup Window when creating a Couple Fact (Marriage, Divorce, 

etc) 

ii. The WebHints list for a Person 

DRAGGING AND DROPPING PEOPLE 

1. Drag & Drop data transfer limitations: 

a. If the Drag & Drop data contains Source Citations based on Custom Source Templates, and 

those Custom Source Templates already exist in the destination file, they will be duplicated  

b. Pre-RM10, This function is actually an internal GEDCOM export and GEDCOM import of the 

selected data between 2 RootsMagic database files.  

i. All limitations and cautions regarding using GEDCOM to exchange RootsMagic data 

apply to Drag & Drop too (see Databases > Importing Data). 

ii. Reminder:  Changes you’ve made in the past regarding Fact Types to export/not export 

into a GEDCOM File should be reviewed to confirm which facts you want transferred to 

the destination database file. 

iii. Unlike an actual import of a GEDCOM File, you’re not given the option to add a Source 

Citation to the People and/or Facts “dropped” into the database to document where 

they came from. 

c. RM10 & On, This function is a direct database transfer of RootsMagic data, bypassing the 

GEDCOM limitations that existed in earlier versions.  

i. All tagged data is transferred, except: 
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(1)  Family Facts involving a Spouse that is not also being transferred.  

(2) Shared Facts when the Person with the original Fact is not also being transferred.  

(3) When the matching Person is not being transferred, DNA Match data entered on the 

Person’s EDIT PERSON Window DNA Matches Page,  

(4) The latest identified limitations of performing a Drag & Drop operation can be found 

in this RootsMagic Community: “RM 10 Drag and Drop Findings” post 

ii. If retaining the original RINs in a new, empty, file is desired; a GEDCOM File 

export/import of the data must be performed with the associated checkbox selected.  

iii. RM10 & On, RootsMagic DOES NOT check for duplicate People beyond the Person being 

dragged and the Person they are Dropped onto (Pre-RM10 limitations can be found in 

GEDCOM Import/Export section).  

(1) So, after the new data is “dropped” into the file and more than one Person is 

involved in the operation:  

(a) Check for duplicate People: 

(b) When duplicate People are found, each Person must be Merged and reviewed 

for: 

a. Duplicate/similar Facts with different information 

b. Duplicate/similar Source Citations for the same Fact  

2. New Custom Facts are created for Fact Types that do not match existing Fact Types.  

3. If the Color Coding Set labels from the source file are desired in the destination file, use the FILE 

Page > IMPORT DATA > IMPORT LISTS function to import them after the Drag & Drop has been 

completed. 

4. Add Parent, Spouse and/or Child links, where appropriate, between the newly added People and 

those already in the database.  

5. Can be used to add People to your “Master” database, extract a portion of your “Master” 

database, or create a set of data to be “further processed” using GEDCOM export capabilities 

(privatize Living People, etc). 

DATABASE TOOLS 

1. Sometimes the Birth & Death dates listed in the PEOPLE Page > SIDEBAR > INDEX View are not 

automatically updated when a Person’s corresponding Facts are edited. The “Rebuild Indexes” 

Database Tool will re-sync the INDEX View dates with the current dates for each event. 

2. Sometimes you’ll notice a completely empty entry for a Person (no RIN displayed, but otherwise 

looks like it’s an existing Person record in the database) in a PEOPLE Page View. These are 

referred to as “Phantom Records.” The “Clean Phantom Records” Database Tool will remove 

these non-existent entries from the database 

3. There’s no recommended frequency to run the database tools. The decision of whether to wait 

until you notice a discrepancy, do it once a year, a month, a week or after significant work has 

been done is left is up to you. I tend to wait until I experience an issue 

4. When you decide to run a Database Tool, I recommend that you run all 4 Database Tools since 

each tool runs very quickly.  

5. The order in which the Database Tools are run does not matter 

6. The Database Tools can be accessed from the FILE and the TOOLS Pages 

https://community.rootsmagic.com/t/rm-10-drag-and-drop-findings/11234
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7. If running the Test Integrity/Integrity Check tool doesn’t result in an “OK,” run the database 

tools a 2nd time. If the result is still not “OK” the database file has an internal integrity issue that 

can’t be corrected. The only option is to locate and Restore a Backup File that does pass the Test 

Integrity/Integrity Check tool with a result of “OK.”  

BACKING UP A DATABASE: 

1. General Info: 

a. Backups can be initiated 3 different ways: 

i. Closing a file by clicking on the “X” (or Mac equivalent) will cause the Backup Popup 

Window to appear, if this setting has been turned on (SETTINGS Page > PROGRAM 

Settings View).  

(1) Reminder: Closing a file from the FILE Page will not trigger the Backup Popup 

Window to appear regardless of this setting. 

ii. Selecting FILE Page > BACKUP function 

iii. Selecting TOOLS Page > BACKUP DATABASE Button 

b. Can be set to include associated Media Files. However, this consumes a significant amount 

of storage space and adds a considerable amount of time to perform the Backup 

i. Primarily recommended when you want a complete set of information (database and 

linked Media Files) for the purpose of archiving a copy or perhaps sharing a copy of 

data and all linked Media Files 

ii. All Media Files are placed in a single Media Folder inside the Backup File. When 

Restored, the Media Files are all Restored into a single Media Folder, any file/folder 

structure used to organize Media Files prior to the Backup is lost. 

iii. If broken links exist in the database prior to creating the Backup File, the corresponding 

Media Files with broken links will not be backed up  

c. Regardless of what’s selected, Media Files not linked to anything and those with broken 

links WILL NOT be backed up 

d. Are primarily intended to support “Undo” resurrection of corrupted database files, 

accidentally deleted data or files, view archived data to compare with current version of the 

database and/or to transfer a database to another computer 

e. RootsMagic Backup Files are actually “Zip Files.” If necessary, you can change the file 

extension to “.zip” and then use separate Zip File software to extract the compressed 

information 

2. When to back up a database file: 

a. Anytime you’ve entered/changed data you’d rather not re-enter should something 

unexpected occur to the file (for me, usually once per day of editing when closing the file) 

b. Prior to performing a major change that can affect multiple records in one action (Examples: 

cleaning up Place Names, Sources & Citations, Merging Duplicates, Search & Replace, Drag & 

Drop People into existing tree, importing GEDCOM data, downloading data from Online 

Sites, etc) 

c. Prior to using any of the following Tools found on the TOOLS Page:  

i. Rearrange children or spouses across the whole database, Delete everyone in a group, 

Change fact type for everyone, Remove a fact type from everyone, (RM10 & On) Add a 

fact to everyone in a group, and DataClean 
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3. If creating a second (or more) Backup in the same day, add a differentiator (dash number or a, b, 

c…) at the end of the filename to make it unique to prevent overwriting earlier Backups, and 

also order the files sequentially when sorted alphabetically by filename 

a. If you’ve made a Backup earlier in the same day and have RootsMagic set up to prompt you 

for a Backup prior to closing the program, RootsMagic asks if you want to overwrite the 

existing Backup:  

i. If you respond “Yes,” the earlier Backup is overwritten  

ii. If you respond “No,” the program closes without making a Backup  

iii. The only way to avoid this situation is to make the final Backup before closing the 

program (FILE Page > BACKUP) and changing the filename. 

RESTORING A BACKUP 

1. General Info: 

a. If you have an RM7 Backup File and don’t have the corresponding database file, you can 

migrate the Backup File data into later versions of RootsMagic by using the Restore function. 

b. When you Restore a Backup File, the Restored File will have the filename of the original 

database file and can’t be changed prior to restoring it. If you don’t want your current 

version of the database file to be overwritten, you must either Restore the Backup File to 

a different folder, or move and/or rename your current database file prior to restoring the 

Backup File. 

c. If your Backup File includes Media Files, all linked Media Files will be placed in a single folder 

created in the location where the File is Restored to and any Media File organization 

structure you’re using will be lost. 

COMPARING DATABASES 

1. General Info: 

a. The % Match value is the result of comparing “all” information in the database about the 

Person, not just what is displayed in the Compare Files Window. A match of 98% or more 

should be considered the same. 

b. The EDIT PERSON Window can be opened for the selected Person in the “Primary” File (the 

open file from which the File Compare function is initiated). The EDIT PERSON Window can’t 

be opened for the Person’s record in the other file being used for comparison. 

c. When selecting Notes, Sources or Media, whichever file you click on becomes the “source” 

for any selected items to be moved to the other file. 

d. For Sources, you can only view the full Source Citation from one file at a time  

e. When a Person is only present in one file, a “Copy To File” Button appears to allow copying 

of all of the Person’s information to the other file. However, the copied Person will not be 

linked to anyone or contain any Family Facts (which depend on linking to other People). Any 

required linking or addition of Family Facts must be done as a separate action. 

2. Given the limitations on editing People, viewing Source Citations and Media Files while using the 

File Compare function, if you expect to be moving a lot of information, or copying People 

between files using the Compare function, consider taking notes on things that need to be done 

afterwards. Some options are: 

a. Take screen shots 
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b. Create an Individual List Report with all "Information to include” & “Other” options 

unchecked and save it to a Word or Excel File so you can search and insert notes, etc and 

things to do after exiting the Compare function 

IMPORTING LISTS 

1. RM10 & On, You can select individual items within a List Type to import 

2. Pre-RM10, Only entire Lists can be imported.  

3. When importing a Fact Type List, RootsMagic imports all Fact Types, except the default 64 built-

in Fact Types included in every file.  

a. Unlike the default 64, all other Fact Types will be imported preserving all the settings as they 

are in the Source File. This includes whether or not the Fact Type will be exported to a 

GEDCOM File and/or included in the other various outputs from the database 

b. If a Fact Type List is imported into a file that already has data in it, duplicate Fact Types may 

be created that will need to be cleaned up.  

4. RM10 & On, When importing an Association Type List, RootsMagic imports all selected 

Association Types, except the default 16 built-in Association Types included in every file. The 

same caveats for preserving settings and duplicates also apply to Association Types. 

Note: If you have individual Custom Source Template Files (*.rmst) that were exported from 

a RootsMagic file, these individual files are imported from the Source Template List Window 

(see Working with Sources > Source Templates in Online Help). 

5. When importing a list of (Custom) Source Templates from a database file, if they already exist in 

the destination file, they will be duplicated.  

6. RM10 & On, Lists of Addresses can be imported. 

7. Importing Color Code Sets will import the labels for each Color Code Set and corresponding 

Color labels. 

IMPORTING DATA (via GEDCOM) 

1. General information: 

a. RootsMagic currently supports v5.5.1 GEDCOM Files 

b. GEDCOM Files are text files that (Pre-v7.0) don’t contain media images or files. Only the 

drive, path and filenames pointing to where linked Media Files reside can be included 

c. For reference, the GEDCOM Website contains the specification for each version along with a 

list of “Validators”  

d. For Reference, the Family Tree Analyzer tool (Windows only) can be used to look at and 

analyze the data in GEDCOM Files  

2. Pre-RM10, The Drag & Drop function is actually an internal GEDCOM export and GEDCOM 

import of the selected data between 2 RootsMagic database files.  

a. Unlike an import of an external GEDCOM File, you are not given the option to add a Source 

Citation to the People and/or Facts “dropped” into the file. 

3. For reference, “SQLite Tools for RootsMagic: GEDCOM & DnD transfer losses #gedcom” is a 

technical post discussing what transfers, what is lost and other issues that occur when 

transferring data between RootsMagic database files via GEDCOM and/or (Pre-RM10) Drag & 

Drop  

https://help.rootsmagic.com/RM11/source-templates.html
https://www.gedcom.org/
https://ftanalyzer.com/
https://sqlitetoolsforrootsmagic.com/gedcom-dnd-transfer-losses/?fbclid=IwAR3kychhZq7qo7UNM1xohUbsdZ0SRYMNj6C7XuWQdznYkFHd4pEGa5y8cn8
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4. When importing data using a GEDCOM File: 

a. If you elect to add a GEDCOM Import Source Citation to the added People and/or Facts, the 

information you enter will appear in reports in the following form: 

i. Source Name: GEDCOM File imported on [DATE] 

ii. Footnote and Short Footnote: GEDCOM File submitted by [NAME], [ADDRESS INFO]. 

Imported on [DATE] 

iii. Bibliography: GEDCOM File, [NAME] 

iv. The corresponding Citation Name will be the same as the Source Name and applied as 

a “Reuse” of the Citation (if the Citation is edited, all uses of it get changed). 

b. After performing a GEDCOM import, check the folder where the destination database file is 

located using a File Manager/Explorer program and open the “LST File” with the same name 

as the imported GEDCOM File, using a program that can read text files, and check for any 

issues encountered by the import tool 

i. You may need to open the GEDCOM File itself, using a program that can read text files, 

to analyze what the data issue is tagged to/located within the imported data set that 

the “LST File” is referring to.  

c. When a group of People are brought directly into an existing file via GEDCOM import (or 

Pre-RM10 Drag & Drop): 

i. RootsMagic DOES NOT check for duplicate People. So, after the new data is inserted: 

(1) Check for duplicate People 

(2) When duplicate People are found, each Person must be Merged and reviewed for: 

(a) Duplicate/similar Facts with different information 

(b) Duplicate/similar Source Citations for the same Fact (note that most imported 

Source Citations not added via Drag & Drop will be imported using the Free 

Form Source Template) 

ii. New Custom Fact Types are created for Facts that don’t match existing RootsMagic 

Fact Types 

iii. Sources and Citations are created using the Free Form Template, rather than your 

preferred Source Template type(s). 

iv. Place Names and Place Details will reflect what was in the GEDCOM File and may not 

conform to your naming and/or structure conventions. 

v. Add Parent, Spouse and/or Child links where appropriate between the newly added 

People and those already in the database.  

d. Check for Broken Media Links in imported data (Media Files are not included in a GEDCOM 

File, only drive, path and filename location information).  

e. Depending on your intended use, you may need to clean up the imported information to 

meet your standards/conventions. 

f. Consider whether you want to make a Backup of your database file to archive a snapshot of 

what it looked like immediately after your importation of this new set of cleaned up data. 

EXPORTING DATA (via GEDCOM) 

1. General information: 
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a. GEDCOM Files exported from RootsMagic using the “Extra Details (RM specific)” setting 

contain all established TreeShare and/or FamilySearch ID mapping established in the Source 

database. When imported back into a RootsMagic file, this mapping is preserved 

i. Pre-RM10, This includes transfer via Drag & Drop 

2. Pre-RM10, The Drag & Drop function is actually an internal GEDCOM export and GEDCOM 

import of the selected data between 2 RootsMagic database files.  

a. If you’ve made changes in the past regarding which Fact Types to not export via GEDCOM, 

you may want to review and change the settings back in order to include them  

3. When exporting data to a GEDCOM File, do the following first: 

a. If Living People need to be privatized, run an Advanced Search to identify all People 

currently identified as living in the Group you intend on Exporting first: 

i. SEARCH Page > ADVANCED Search View 

ii. Click FIND Button 

iii. RM11 & On, Add Rule: “Individual Attribute,” set “Living” to “Is True”, and then click on 

“OK” 

iv. Pre-RM11, Add Rule: “Criteria,” “Edit Criteria,” set “Select field” to “Living Flag” and “Is 

True” in the Logic box, and then click on “OK” 

v. The result is a list of all the current People that will be privatized. If you see People that 

shouldn’t be privatized, select them and click on EDIT Button to make the necessary 

corrections 

vi. Repeat until review is complete 

b. The initial default setting for each newly created RootsMagic file is set to export all built-in 

(default) Fact Types. Decide whether you want all, or only some Fact Types to be exported. 

Confirm export settings for each Fact Type is set as you want, as follows: 

i. Select PEOPLE Page, and open Fact Type List 

ii. Note where the “Include GEDCOM: Yes/No” information is located on the Fact Type 

screen 

iii. Scroll through the Fact Type List to confirm the desired Fact Types you want to include 

are set to “Yes” and any Fact Types you don’t want to include are set to “No” 

Note: If you click on the first Fact Type, you can then scroll through the list by using 

the Down Arrow Key 

iv. To change a setting, click on the EDIT Button, check/uncheck the “Include when 

Exporting GEDCOM Files” box and click OK 

v. Continue to the end of the Fact Type List, then click OK 

c. If you’re exporting a subset of People in your database and you haven’t created a Group yet, 

you may want to create a new Group prior to starting the process to export the GEDCOM 

File 

i. Reminder: Couple/Family Facts will only be included in the export if both People are 

included in the export 

d. If the data you want to export contains links to Media Files, check for & fix, broken media 

links (TOOLS Page > MEDIA TOOLS > Fix broken links) first. 

e. If you want the colors assigned for each Color Code Set to be included in the export, you 

must ensure that “Extra details (RM specific)” is selected on the GEDCOM Export Options 
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Window. Only the color assignments are included, the Color Code Set and Color labels are 

not included in the resulting GEDCOM File. 

f. Now you’re ready to export the GEDCOM File 

g. After exporting data to a GEDCOM File:  

i. If some Fact Types were set to not export, decide whether to reset them to “Yes” now, 

or wait until the next time you perform a GEDCOM Export (or Pre-RM10, Drag & Drop) 

operation to review all Fact Type export settings. 

ii. RM9 & On, If you exported color coded data and want to also transfer the Color Code 

Sets and Color Labels from the source file, you can import the Color Code List from the 

Source RootsMagic File (FILE > IMPORT DATA > IMPORT LISTS and select the desired 

Color Code Sets) to another RootsMagic file, after the GEDCOM File is imported 
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WORKING WITH PEOPLE  

GENERAL INFORMATION:  

1. After importing data from other sources, you may discover multiple “Primary Name” Facts for a 

Person, when there should only be one:  

a. To reset the Primary Name, create a new, temporary, name, designate it (temporarily) as 

the Primary Name. This will reset all other Primary Names to Alternate Name Facts. Then, 

select the desired “real” Primary Name and finally, delete the temporary name created. 

2. Sometimes you’ll discover a Person has an unexpected “Unknown Spouse” listed in the 

DESCENDANT View. This is not a record for a Person in the database. It’s an indication of a 

Family/Couple relationship created either by linking a Child to just 1 parent or a Family Fact that 

requires a Couple (like Marriage) and only 1 Person is associated with it.  

a. If one of these relationship situations actually does exist in the family, then there is nothing 

to “fix” 

b. There are situations that can occur where the original cause was corrected, but the 

Family/Couple with an unidentified Spouse still exists in the database. These can be 

corrected by following the Resolving “linking issues” steps listed in the Problem Solving 

Information section at the end of this document. 

c. If caused by data imported from another source, when possible, it’s best to return to the 

source, correct the problem there and then re-import the information 

3. Information on dealing with sensitive Family situations such as transgender Relatives can be 

found here: 

a. Yvette Hoitink’s “Ask Yvette – How to Record Transgender People?” Blog  

b. Stewart Traiman’s “Six Generations” website  

4. General information on what and where to enter People’s names can be found here: 

a. Tamura Jones blog: “Modern Software Experience – Genealogy Name Basics”  

5. Naming convention information for different areas of the world can be found here: 

a. Personal Names – “Wikipedia: Personal Name”  

b. Dit Names – “Wikipedia: Dit Names”  

c. Dutch Farm Names -  “Yvette Hoitink Blog: Farm Names”  

d. Scandinavian Family Names – “Wikipedia: Scandinavian Family Name Etymology”  

e. Patronymic Names – “Wikipedia: Patronymic [Names]” and “FamilySearch: How do I enter 

Scandinavian names into Family Tree?”  

ADDING PEOPLE 

1. Selecting “Add an Individual” adds a Person to the database with no relationship to anyone else. 

The other Add options (Spouse, Child & Parents) establish the selected relationship to either a 

new, or Existing Person. 

2. It’s a best practice to add People from a PEOPLE Page View that ensures you’re establishing the 

correct relationship links: 

a. When known, “Add Parents” to a Child as a Couple, rather than adding Mother and Father 

separately.  

i. Caution: If the Couple has already been established in the database, don’t use the 

individual “Add Father” and “Add Mother” Buttons on the PEDIGREE View to add 

https://www.dutchgenealogy.nl/ask-yvette-how-to-record-transgender-people
https://sixgen.org/
https://www.tamurajones.net/GenealogyNameBasics.xhtml?fbclid=IwAR2WpaawV8JtY51XDuAwVqLH_3OAE5d3WAShW7moC84ElCFj9nH9W8-0aHM
https://en.wikipedia.org/wiki/Personal_name
https://en.wikipedia.org/wiki/Dit_name
https://www.dutchgenealogy.nl/farm-names
https://en.wikipedia.org/wiki/Scandinavian_family_name_etymology
https://en.wikipedia.org/wiki/Patronymic
https://www.familysearch.org/en/help/helpcenter/article/how-to-enter-scandinavian-names-into-family-tree
https://www.familysearch.org/en/help/helpcenter/article/how-to-enter-scandinavian-names-into-family-tree


GFO RootsMagic SIG Handout 

Page 28 of 84 2 March 2026 

additional Children to the Couple. Doing so will result in the Child being assigned to its 

own unique set of Parents/Couple (even though they may be the same 2 People), and 

need to Resolve “linking issues” to properly link all the Children to the same 

Family/Couple in the database. 

b. When adding Children to a Couple already established in the database, the best practice is 

to add them from the FAMILY or DESCENDANT View, where you can ensure you’re linking 

the Child to the correct Existing Couple 

3. People can be added by: 

a. Clicking on “ADD” on any PEOPLE Page View and then selecting the type of relationship 

being added 

b. Clicking on the “+ Add Child, Spouse, Mother or Father” Boxes found on the PEDIGREE and 

FAMILY Views 

c. Hover over a Person and right-clicking 

d. Keyboard shortcuts 

e. Click on COMMAND PALETTE Icon 

f. From the selected Person’s PEOPLE Page > SIDEBAR > (RM11 & On) LIFE SUMMARY/(RM8 to 

10) INFO View 

4. The minimum data that must be entered for a new Person to be added to the database is: 

a. Something entered in either the Given or Surname data fields. All other information is 

optional 

b. If desired, you can create a record for a Person with no name by:  

i. Step 1:  Create a Person with a Temporary Name entry 

ii. Step 2:  In the newly created Person’s EDIT PERSON Window, delete their Temporary 

Name. It’sI highly recommended that the RIN  (Record ID Number) display be turned on 

(SETTINGS Page > GENERAL Settings View) to aid in differentiating multiple records 

with no name entered 

5. If 2 People are siblings, but their parents are unknown, you can connect them by creating a 

record for their Father with the same Surname as a placeholder. Once created, link the siblings 

to the Father to establish their relationship to each other 

EDITING A PERSON 

1. You may want to position the EDIT PERSON Window so that part of it’s outside the area of the 

main program Window so that it can be clicked on it to bring it to the front should it get hidden 

2. You can have up to 3 open EDIT PERSON Windows (1 in the free version) and still switch 

between Pages and database file Windows.  

3. To close an EDIT PERSON Window, click on the “X” (Windows) in the corner 

4. You can change the Father & Mother labels to be displayed when viewing the Couple’s Family by 

editing the labels to be used on the Parent’s “Spouse row” in their EDIT PERSON Window. 

5. You can define the Parent’s relationship to their Children by editing the type of relationship on 

the Child’s “Parents row” in their EDIT PERSON Window 

UNLINKING PEOPLE 
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1. Unlinking can be performed from any PEOPLE Page View. However, it’s a best practice to 

perform unlinking from a View that ensures both you and RootsMagic clearly understand which 

relationship link you are about to unlink.  

a. The best View to use to understand “All” of the family relationships is the DESCENDANTS 

View and the best View to use for unlinking people in a family is the FAMILY View, where 

Children are shown with only 1 set of Parents and when a Parent has multiple Spouses, 

which one is part of the Family/Couple involved in the unlinking. 

2. When a spouse is unlinked, if the Couple had children linked to them, the children remain linked 

to the spouse and their other parent will then be identified as “Unknown Spouse.” 

DELETING PEOPLE 

1. In most cases, deleting a Person is not the way to correct a problem you’re trying to fix. Prior to 

proceeding with a deletion ask yourself: 

a. Should I Manually Merge the People instead?   

b. Should I leave this Person (or Family/Couple) floating in my database file as a separate tree 

to preserve what I already know about them? 

c. If the answer to both questions is no, then it’s time to delete the Person 

2. Reminder: When a Person is deleted: 
a. Any links the deleted Person (or Family/Couple) had with other People in the database are 

also deleted. This includes: 
i. Links to the Person’s Parents, Spouses and their Children  

ii. Association links to other People in the database 
iii. Shared Facts, shared with other People in the database 
iv. DNA Match data they have with other People in the database 
v. Links to Source Citations, Media, Tasks, etc are deleted 

b. Reminder: Even though links to Source Citations, Media, Tasks, etc are deleted, the actual 
Source Citations, Media, Tasks, etc ARE NOT DELETED from the database. They are just used 
in fewer places in the database. 
i. RM10 & On, After deleting a Person, you can review the reported number of data types 

that are “Unused” (TOOLS Page > ENHANCED PROPERTIES LIST) and decide if you want 
to select and delete them as well. 

ROOTSMAGIC EXPLORER 

1. The ROOTSMAGIC EXPLORER Window can be utilized when using the following functions: 

a. Creating and editing “Simple” Groups  

b. One of several options to apply Color Coding  

c. RM10 & On, Copying a Fact 

d. Selecting People from list to include in some PUBLISH Page > REPORTS AND CHARTS 

2. The MARK/UNMARK capability allows very creative ways of “Selecting” a set of People. 

a. There is no limit to the number of MARK/UNMARK operations that can be performed to 

create the final list of People you want to “Select”  

b. However, if you perform multiple MARK/UNMARK operations, they can’t be saved to be 

repeated again later. Therefore, it’s important to record each step, and the order the steps 

are performed, in order to be able to recreate the same selection criteria in the future:  
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i. RM10 & On, As an alternative, you can create and save a “Rules-Based” ADVANCED 

SEARCH, which can record multiple Select/Unselect (MARK/UNMARK) operations that 

can be reproduced in the future. The saved search can then be used to Mark the 

People using the “Saved Search” Mark option in the ROOTSMAGIC EXPLORER Window 

(1) RM11 & On, Reminder: You can also save a Rules-Based ADVANCED SEARCH as a 

Group 

ii. RM10 & On, As another alternative, you can create a “Rules-Based” Group that can be 

refreshed. A Rule can be created for each MARK/UNMARK operation, applied in the 

desired order. 

c. RM9, If you plan to select People using a single application of the “By Data Fields” option, 

it’s recommended that you create a Group using the Saved Criteria option instead. This will 

allow you to quickly refresh the group membership in the future.  

GROUPS 

1. Caution: Be careful when naming Groups. RootsMagic will allow 2 different Groups with the 

same name to be created 

2. Group membership is not updated as information about People is changed and saved, 

membership only gets updated when each Rules-Based Group is “Refreshed” 

3. When People that are members of different Groups are “Merged,” only the Group membership 

of the Primary Person is retained. All Group memberships of the Person that ends up being 

removed is not passed on to the surviving Primary Person’s record. 

4. RM10 & On, This RootsMagic blog article: “Memorial Day Preparations: Buried Twice?” provides 

an example of how to use Rules-Based Groups  

5. Using Rules-Based Groups based on Custom Facts is a powerful way to define collections of 

People for work, reporting, etc. Custom Facts can be privatized to prevent them from being 

included in reports, etc 

6. When large Groups (>1,000 People) are created using ”Rules” and the Group is used to filter the 

list of People shown in the PEOPLE List View or SIDEBAR > INDEX View, the performance of 

RootsMagic is known to slow down its response time for other actions.  

COLOR CODING PEOPLE 

1. Consider reserving one of the 10 Color Sets for “Temporary” color coding in case the need to 

color code while performing a specific task you are working on arises 

2. Unless you plan to “Select” People using the ROOTSMAGIC EXPLORER Window or a pre-defined 

Group, color coding will be based on the Person selected prior to opening the Color Coding tool 

3. For reference, “SQLite Tools for RootsMagic: Colorcoding #RM8 #RM9” is a technical post 

discussing color codes and color selection  

SET RELATIONSHIPS 

1. The Person set as the “Root Person” and the Person selected to "Show Relationships To” are 

two different designations in the database file. 

2. Set Relationships does not automatically update relationships when relationship links are 

changed or new People are added to the database. The Set Relationships function must be re-

run to update the information displayed. 

http://blog.rootsmagic.com/?p=3843
https://sqlitetoolsforrootsmagic.com/colorcoding-rm8/?fbclid=IwAR2rdgnZeTALa1LNvu_NN9sFHX_y9-gjCnm23vo3Z_krTAwOY3ECUZkV_fo
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WEBHINTS 

General Information: 

1. WebHint Icon Legend in Online Help  

2. Per RootsMagic Tech Support, each company decides when to update their WebHint 

information:  

a. RootsMagic sends a WebHint request for each Person currently being displayed on the 

PEOPLE Page including the latest data in the database file about each Person. RootsMagic 

then waits for each company to respond with their updated set of WebHints for each 

Person.  

b. The number of WebHints for any Person can change at any time due to: 

i. Changes made to the Person’s information in the RootsMagic database  

ii. The addition of new online records or a new catalog collection applicable to the Person 

iii. Other online users finding and associating record information about the same Person to 

their family tree 

3. RootsMagic does not store WebHint information in the database file. It relies on each company 

sending WebHint responses requested every time a new Person is displayed on the PEOPLE Page 

4. After changing the status of a WebHint, it will not be reflected in a Person’s WEBHINTS 

Summary Window until the Window is closed and re-opened. Re-opening the Window triggers 

sending the updated information back to the company’s hinting system and waiting to receive 

updated WebHints sent back to RootsMagic (in some cases, this can take several minutes). 

Ancestry WebHints: 

1. Ancestry generates Hints for the People and their Profile information contained in the Ancestry 

Tree connected to the RootsMagic file and passes (mirrors) these as WebHInts to RootsMagic 

via the TreeShare connection. 

a. Reminder: In addition to the general list of reasons listed above, Ancestry tends to also 

generate new Hints based on the areas of the connected Ancestry tree that are viewed 

2. Ancestry WebHints can only be seen while logged into Ancestry via TreeShare. 

3. Unlike the TreeShare function which provides transfer of information in both directions, 

processing Ancestry WebHints only results in changes to the RootsMagic database.  

a. If changes are desired to be made to the linked Ancestry Tree, TreeShare must be used to 

select which changes you want to incorporate into the connected Ancestry Tree. 

4. Regardless of where you click on the Ancestry WebHints row in the WEBHINTS Summary 

Window, the ANCESTRYHINTS Window opens, showing all WebHints grouped by type (Records, 

Other Member Trees & Photos and Stories) and sorted by status (Undecided, Accepted, 

Rejected). 

5. Users without an Ancestry subscription that provides access to Records & Other Member Trees 

can still view records that Ancestry makes available for free and all User uploaded Photos and 

Stories. Since you can’t tell which records are free from within RootsMagic, you may find it 

useful to look at each WebHint while looking at the detailed field information contained in the 

WebHint compared to the information entered in the RootsMagic database 

a. In order to view Photos and Stories files, Users without a subscription must first attach the 

file to the Person and then open/view the file from the Person’s EDIT PERSON Window 

https://help.rootsmagic.com/RM11/webhints.html


GFO RootsMagic SIG Handout 

Page 32 of 84 2 March 2026 

6. Unlike from within Ancestry, Users without a subscription can change the status of WebHints 

(Undecided, Accepted or Rejected), and revise the status in the future, if needed.  

a. Status changes made to RootsMagic WebHints are passed back to the connected Ancestry 

Tree list of Ancestry Hints. 

7. Processing of Ancestry WebHints involves the following basic steps: 

a. View WebHint, when possible 

b. View highlighted data differences between Ancestry Hint and RootsMagic Person 

c. Decide whether sufficient information is available to decide: 

i. WebHint is applicable and should be Accepted 

ii. WebHint is not applicable and should be Rejected 

iii. Further information is needed before deciding applicability and should be left as 

Undecided 

d. When a WebHint is accepted, decide whether to transfer data from the WebHint to the 

RootsMagic Person and/or click on EDIT ROOTSMAGIC PERSON Button to open the Person’s 

EDIT PERSON Window to manually make the changes  

i. Data can be transferred from the Ancestry WebHint to RootsMagic as a new Fact or 

replace data in a current Fact 

e. Decide whether to add/modify the Ancestry Source Citation in RootsMagic 

f. When done working WebHints for the Person, decide whether any of the changes in the 

RootsMagic Person from the WebHint review should be “pushed” back to Ancestry Tree 

using TreeShare 

FamilySearch WebHints: 

1. FamilySearch WebHints can only be seen while logged into FamilySearch via RootsMagic  

2. FamilySearch provides Record Hints for the FamilySearch Family Tree (FSFT) based on the 

information entered for the People in the RootsMagic database and whether or not they have 

been matched to the corresponding Person in the FSFT.  

3. Processing these WebHints does not change any information about the Person in the 

RootsMagic file, it only affects the Hints for the People in the FSFT and whether or not the 

hinted record gets attached to the FSFT Person. 

a. When the RootsMagic Person has been matched to a Person in the FSFT, both Pending and 

Confirmed WebHints are provided (not sure if Rejected WebHints show in updated status or 

just disappear from the WebHints Window).  

i. Confirmed WebHints means they are attached to the FSFT Person.  

ii. Not all Record Sources attached to a Person in the FSFT are presented as WebHints in 

RootsMagic. 

b. When the RootsMagic Person has not been matched to a Person in the FSFT, WebHints ARE 

NOT provided. 

4. Evaluation and processing of each WebHint consists of: 

a. Starting at the FamilySearch webpage linked to the WebHint entry in RootsMagic 

b. Using the established FamilySearch process for dispositioning FSFT Hints. 

5. After processing Hints in the FSFT you may want to add data to the RootsMagic database from 

the FSFT (see Online Features > FamilySearch in Online Help) 

FindMyPast WebHints: 

https://help.rootsmagic.com/RM11/familysearch.html
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1. FindMyPast provides only Record WebHints, based on a Person’s information entered in the 

RootsMagic database. 

2. Regardless of where you click on the FindMyPast WebHints row in the WEBHINTS Summary 

Window, a Browser Window opens showing all the FindMyPast WebHints for the Person. 

a. Each listed WebHint identifies the FindMyPast Record database, with very limited specific 

information about what the record contains 

b. If you have a free FindMyPast account and log in, you can’t use the Review and Accept 

functions, but you can Reject a WebHint 

i. In some cases, you may still be able to go into the FindMyPast site and search for the 

Person, locate the Record WebHint and see the complete database index transcription  

c. If you have a paid FindMyPast subscription and log in, you can Review, Accept and/or Reject 

each WebHint 

i. The ability to change the status of a WebHint is done from within FindMyPast and can’t 

be done from RootsMagic. 

3. Since there is no data exchange capability between RootsMagic and FindMyPast, any valid 

WebHint information must be manually entered into the RootsMagic database, regardless of 

whether you have a subscription or not. 

4. Issues using the FindMyPast WebHint webpage linked to from RootsMagic may get resolved by 

clearing browser history 

MyHeritage WebHints: 

1. MyHeritage provides Record and Smart Match (Member Tree) WebHints, based on a Person’s 

information entered in the RootsMagic database. 

2. Regardless of where you click on the MyHeritage WebHints row in the WEBHINTS Summary 

Window, a Browser Window opens showing all MyHeritage WebHints for the Person, grouped 

by WebHint type (Records and Smart Matches). 

a. Each listed WebHint identifies some, but not necessarily all information contained in the 

WebHint. 

b. If you have a free MyHeritage account and log in, you can’t use the Review and Accept 

functions, but you can Reject a WebHint 

i. However, if the Record dataset containing the WebHint is marked as “Free”, you can 

Review,Accept and/or Reject the WebHint 

ii. Similar to FindMyPast, you may find that you can access and review some WebHint 

Record datasets by logging into your MyHeritage account, search for the Person, locate 

the Record WebHint dataset and see the complete database index transcription entry. 

c. If you have a paid MyHeritage subscription and log in, you can Review, Accept and/or Reject 

each WebHint. 

i. Tracking of Accepted and Rejected WebHints is done within your MyHeritage account. 

ii. The ability to change the status of a WebHint is done from within MyHeritage and can’t 

be done from RootsMagic. 

3. MyHeritage can suppress WebHints that you’ve already attached to your MyHeritage family tree 

associated with the e-mail account entered on the SETTINGS > WEBHINT Settings View. If 

activated, once a WebHint is dispositioned in the MyHeritage account, it will be suppressed and 
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not sent to RootsMagic as a WebHint. As a result, when filtered, I believe all MyHeritage 

WebHints listed will be listed as Pending in RootsMagic. 

4. Since there is no data exchange capability between RootsMagic and MyHeritage, any valid 

WebHint information must be manually entered into the RootsMagic database, regardless of 

whether you have a subscription or not. 

5. Issues using the MyHeritage WebHint webpage linked to from RootsMagic may get resolved by 

clearing browser history 

SET LIVING 

1. Since this tool can change multiple People at one time, it’s recommended that a Backup File be 

created before proceeding 

2. If sharing data with Online Sites, care must be taken to correctly flag all Living People to ensure 

the Online Sites properly protect information about Living People. 

RM10 & On, HEALTH HISTORY 

1. General Information: 

a. Health data can’t be searched, nor filtered, using any of RootsMagic’s Search tools  

b. Health data can’t be exported out of RootsMagic via Ancestry, FamilySearch or GEDCOM File 

export 

c. Health data can be transferred to another RootsMagic file using Drag & Drop. 

2. The Health Condition “Details” data field is limited to 102 characters. However, the “Health 

Note” data field, like all Note fields in RootsMagic, has no character limitation. 

3. Health information entered in the EDIT PERSON Window > HEALTH History Page is kept separate 

from all Facts and other information used to create typical genealogy reports. This allows the 

separate tracking of health-related issues that might have hereditary connections without 

having to be concerned about inadvertently publicizing personal/private information regarding a 

Person’s health history. 

4. Similar to entering Addresses for living People to create/manage an address book of People, 

entering/tracking health history is optional data that has no impact on outputting standard 

genealogical information from RootsMagic. But, RootsMagic does generate the Health History 

specific reports (Family Health History & Health Conditions). 

RM10 & On, DNA TESTS 

1. General Information:  

a. RootsMagic provides 3 different built-in features specific to recording DNA Match data in 

the database file: 

i. “DNA Test” Fact Type: 

(1) The default configuration doesn’t use the Description field. Like other Fact Types, it 

can be activated and added to the Sentence Template, if desired. 

(2) Defining Supporting Roles and Sharing the Fact with others may be useful, 

depending on your overall approach to adding and managing DNA Test and Match 

data. 

(a) Pros:  
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i. A single DNA Test Fact assigned to the Tester could be “Shared” with all 

DNA Matches.  

ii. All relevant DNA Match data can be entered in the Supporting Role’s Note 

field.  

iii. RM11 & On, Reminder: You can create Rules-Based Advanced Searches and 

Groups based on Shared Fact information  

(b) Cons:  

i. Reminder: Shared Facts may not be able to be exported to other sites or 

programs 

ii. Pre-RM11, Reminder: You can’t create Advanced Searches or Groups based 

on Shared Fact information  

(3) Reminder: Facts can be: 

(a) Searched and filtered. 

(b) Exported out of RootsMagic via Ancestry (TreeShare), FamilySearch and 

GEDCOM File export, but Shared Facts aren’t recognized in most other 

programs 

(c) Additional Custom Fact Types can be created 

ii. “DNA Match” Association Type: 

(1) The default configuration uses the Description field. 

(2) Associations can’t be shared, so an Association is required for each DNA Match 

being recorded, potentially leading to 100’s or 1,000’s of entries for a Person. 

(a) The display of Associations in the EDIT PERSON Window can be turned off. 

Unfortunately, it will apply to all Associations, not just the DNA Match 

Association Type. 

(3) Reminder: Associations:  

(a) Can be searched and filtered 

(i) Pre-RM11, You can’t search for specific Association Types 

(b) Can be transferred to another RootsMagic file using Drag & Drop, but only if 

both People forming the Association are included in the D&D operation. 

(c) Can’t be exported out of RootsMagic via Ancestry (TreeShare), FamilySearch or 

GEDCOM File export 

(d) Additional Custom Association Types can be created. 

(4) RootsMagic reports (including Custom Reports): 

(a) RM11 & On, Can be limited to just the DNA Match Association by using a Rules-

Based Group 

(b) Pre-RM11, Can’t be limited to include just the DNA Match Association. The 

reports can only be set to include all Associations, or none 

iii. EDIT PERSON Window > DNA Matches Page: 

(1) DNA Matches Page data can’t be searched, nor filtered, using any of RootsMagic’s 

Search or Group tools  

(2) DNA Matches Page data can’t be exported out of RootsMagic via Ancestry 

(TreeShare), FamilySearch or GEDCOM File export 



GFO RootsMagic SIG Handout 

Page 36 of 84 2 March 2026 

(3) DNA Matches Page data can be transferred to another RootsMagic file using Drag 

& Drop, but only if both People forming the DNA Match are included in the Drag & 

Drop operation. 

(4) RM10 & On, If DNA Match Associations were created in RM9, as part of the initial 

database file “Conversion” process to a later version database file, in addition to 

converting the DNA Match Associations, a DNA Match Page entry for the 2 People 

identified in each DNA Match Association was created.  

b. User submitted ideas for managing DNA Match data in RootsMagic: 

i. Include URLs for the Profile Page at DNA sites using a WebTag, the Description field, or 

the Note field. Reminder:  

(1) WebTags are only included in the WebTag List Report 

(2) URLs placed in the Description field cannot be used as hyperlinks 

(3) When placed in a Note: 

(a) The URL can be accessed by pressing the Crtl-Key and clicking on URL 

(b) It can be treated as Private data by enclosing it in curly “{ }” brackets 

(4) Can be placed in a Custom Fact Type that can be enabled/disabled for additional 

control over inclusion in database outputs  

ii. Use Tasks to tag a DNA Fact or Association and rely on Task Research Log folders to 

track progress in identifying Most Recent Common Ancestors (MRCA). 

iii. Use Sources for each DNA testing company to place DNA Match details, notes and 

Match Profile URLs in the Citation Details for each DNA Match (which can be tagged to 

both People) 

iv. Use a DNA (     ), or other colored symbol, Emoji for visibility purposes. 

c. There are no provisions for adding DNA Match data using bulk/automated methods. All DNA 

Match data must be manually entered  

i. Ancestry controls the TreeShare interface capabilities. This interface does not allow 

access to any AncestryDNA data 

ii. Some Tech Savvy Users are exploring methods using external 3rd-party tools to 

externally bulk load DNA Match data into a database file for access via the EDIT 

PERSON Window > DNA Matches Page  

d. Time should be spent developing a consistent “Overall DNA Strategy” that weighs the Pros & 

Cons of each of the approaches mentioned above, and any other ideas you may develop, to 

document DNA Test and Match information that supports your: 

i. Desired output reporting capabilities 

ii. Desired searching, filtering, grouping and color-coding capabilities 

iii. Desired research/analysis capabilities 

iv. Desired post-research/analysis capabilities 

v. Willingness to expend the time and effort to include it in your database vs manage DNA 

research separately 

2. EDIT PERSON Window > DNA Matches Page 

a. DNA Match information entered in the EDIT PERSON Window DNA Matches Page is kept 

separate from all Facts and other information used to create typical genealogy reports. This 

allows the separate tracking of DNA Match-related information without having to be 
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concerned about inadvertently publicizing personal/private information regarding a 

Person’s DNA Matches. 

b. Similar to HEALTH History Page data, entering/tracking DNA Match data on the EDIT 

PERSON Window > DNA Matches Page is optional information that has no impact on 

outputting standard genealogical information from RootsMagic, but does allow the 

generation of DNA specific reports (DNA Kinship List & Leeds Method Report). 

c. Depending on your specific situation, entering DNA Match information from multiple 

companies into one place may be useful when attempting to view and analyze all 

information available (including having RootsMagic perform Leeds Method analysis rather 

than doing it manually, in a spreadsheet or other DNA 3rd-party software) in order to solve, 

or confirm, family tree relationships. 

d. If unfamiliar with DNA and/or DNA analysis techniques, I recommend considering joining the 

GFO DNA Q&A Special Interest Group  

e. DNA Notes entered on the EDIT PERSON Window > DNA Matches Page can’t be included in 

any of the RootsMagic DNA reports. DNA Notes are only viewable when viewing the Tester 

or DNA Match’s information on the Person’s DNA Matches Page 

i. Reminder: The contents of any Note can be viewed by hovering over the visible text in 

the Note field   

f. Every DNA Match entry that does not have a known “Tree Relationship” when initially 

created will start as a floating tree containing only one Person.  

i. RootsMagic does not automatically update the “Tree Relationship” data for DNA 

Matches after their initial entry  

ii. After adding new links that connect a DNA Match to the Primary Tree, in order to 

update the “Tree Relationships” on the DNA Match Page, you must select each affected 

DNA Match and click on the blue “Update” Button in the lower right to force 

RootsMagic to re-evaluate the DNA Match’s “Tree Relationship.” 

g. Consideration should be given to establishing a “System” for being able to discern floating 

trees containing DNA Match individuals from People added to the database for Non-DNA 

reasons (FAN club, One Name Studies, etc) without having to open the Person’s EDIT 

PERSON Window to review their detailed information. Some possible options include: 

i. Entering something in Name Suffix field 

ii. Using the Reference Number Fact Type 

iii. Using Emojis 

iv. Etc 

  

https://gfo.org/learn/special-interest-groups/dna-qa.html
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WORKING WITH FACTS 

THE EDIT PERSON WINDOW 

1. (Not in RM9 Online Help) You can switch to Close Relatives of the current Person in the EDIT 

PERSON Window without leaving the Window by clicking on the down arrow for the appropriate 

Spouse or Parent to pick the desired Spouse, Child, Parent or Sibling you want to switch to  

2. Checking the “Show Relative Events” check box: 

a. Shows Events for the Relatives selected on the OPTIONS Window that occurred during the 

lifetime of the Person being edited.  

i. Note that when a Relative’s Marriage Fact is selected to view, the sentence displayed in 

the Sentence area will only include the Relative and not their Spouse. To view the 

complete sentence that will appear when a Narrative Report is generated, you must 

view the Fact from the Relative’s EDIT PERSON Window. 

b. If the Person being edited does not have a Birth or Christen Fact date, then no Relative 

Events are displayed because RootsMagic can’t determine whether they occurred while the 

Person was alive. 

3. When the “Slide-In Workflow” checkbox is checked on the SETTINGS Page > PROGRAM Settings 

View, clicking on the corresponding column location for a Fact causes the selected information 

to appear on the left side and the additional detail information on the right side.  

4. Proof: 

a. The Proof data field can be found for each Spouse, Parents and Fact entry  

b. Each Proof data field has a drop list and can be set to: blank, Proven, Disproven, Disputed or 

(RM11 & On) Proposed 

i. RM11 & On, When the “Proof” data field is set to anything other than blank, a 

corresponding “Proof” icon is displayed after the Fact name in the Facts Column 

ii. Pre-RM11, When the “Proof” data field is set to either Disproven or Disputed, the Fact 

entry in the EDIT PERSON Window timeline list is shown in red with a strike through 

line across the text  

c. Proof status is not included in any of the RootsMagic reports, it’s only an internal visual 

reference. If external reporting is desired, an enhanced approach to documenting Proof 

needs to be implemented that utilizes data that can be included in reports  

d. If you decide to use the Proof data field, this “FamilySearch Wiki - Genealogical Proof 

Standard [GPS]” article may help you decide how you want to define the application of each 

of these choices  

ADDING FACTS 

1. Facts can be added by clicking on the Add Fact (+) icon, or hover over a Fact and right clicking. 

2. When selecting the Fact Type, you can: 

a. Use partial word searches and/or use the wild cards “_” and “%” 

b. Use the quote (“) to indicate the name must start with the text that follows  

3. When entering the: 

a. Date: The Calendar and Date Calculator Tool icons appear at the far right of the Date data 

field 

https://www.familysearch.org/en/wiki/Genealogical_Proof_Standard
https://www.familysearch.org/en/wiki/Genealogical_Proof_Standard
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b. Place: The Gazetteer tool and Select Place (already in the Place List) icons appear at the far 

right of the Place data field 

c. Place Detail: The Select Place Detail (in Place Detail List) icon appears at the far right of the 

Place Detail field 

4. Sometimes Users have trouble deciding which Fact Type to use when they encounter a new type 

of record:  

a. The following questions and answers may help guide you to consistent decisions: 

i. Is the information a Fact or an Association (Non-Family relationship) that needs to be 

recorded; or is it information to be used to “prove” a Fact or an Association already 

recorded? 

(1) If proving something already entered, then it probably should be treated as a 

Source Citation, not a new Fact Type  

ii. How often is this situation going to occur in your database? 

(1) If rare, consider using the Miscellaneous Fact Type and customizing the sentence 

for each specific use 

(2) If many, consider creating a Custom Fact Type instead 

iii. Regardless of how often it occurs in your database, do you envision wanting to use 

filter/search criteria for this Fact in the future? 

(1) If yes, consider creating a Custom Fact, even if used only a few times. Unless you 

intend on consistently using different text strings in the Description data field of 

the Miscellaneous Fact Type that can be searched for 

(2) If no, consider using the Miscellaneous Fact, or create a Custom Fact, depending on 

how often it will be used in the database file.  

b. After reviewing the above questions and answers on how to handle the new record, the 

following may help evaluate your decision prior to implementing it: 

i. First, recognize that there isn’t always a single correct answer. In the end, it’s left to 

each genealogist to decide, based on their approach and philosophy to documenting 

their Family History Research, how to proceed  

ii. Do you plan to transfer your RootsMagic information with external sites and/or other 

software programs? 

(1) If yes, to avoid the risk of major re-work in the future, be sure to test how your 

decision to proceed transfers to other sites and/or software programs 

(2) FYI, despite my full embracement of RootsMagic, to keep my options open in the 

future, I still confirm anything I decide to do is exportable via GEDCOM and I 

understand whether or not it transfers to Ancestry via TreeShare and to 

FamilySearch  

iii. Do you plan to output Narrative Reports? 

(1) If yes, be sure to test how your decision to proceed appears in Narrative Reports: 

(a) Does the information appear in the desired section of a Person’s report? If not, 

refine the solution until it meets expectations 

(2) Does the Sentence Template produce text that fits with other Fact sentences, 

without repeating information found in other Facts? 
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iv. If you decide to both create a Fact and use the record as a Source Citation, the extra 

effort of doing both should be “Value Added” towards what you want to accomplish in 

your documented research? 

Date Formats 

1. RootsMagic supports four Date Formats. The following image shows how each is displayed when 

the SETTINGS Page > GENERAL Settings View > Date Format is set to “10 Jan 1959.” When set to 

a different option, these formats will be presented slightly different: 

 

2. Double Dates – Additional double date info can be found here: “Wikipedia: Old Style and New 

Style dates”  

3. Quarter Dates – This date format is currently not mentioned in the Online Help: 

a. Quarters can be entered in a variety of recognizable formats which are converted into the 

form of: March Quarter, June Quarter, September Quarter & December Quarter 

b. In addition to entering the resulting format, various combinations of “first” or “1” and 

“quarter”, “qtr” or “q” are recognizable data entry formats 

c. Quarter dates are sorted as if they occurred in between the last day of the prior quarter and 

the first day of the listed quarter.  

i. For example, “March Quarter” would be sorted and placed after events that occurred 

on 31 December of the prior year and before 1 January of the current year 

4. Directional modifiers – RootsMagic will recognize the following entered text and convert it to 

the indicated modifier: 

a. Enter either “b” or “bef” and RootsMagic will convert it to “before” 

b. Enter “untl” and RootsMagic will convert it to “until” 

c. Enter either “f” or “fr” or “frm” and RootsMagic will convert it to “from” 

d. Enter either “a” or “aft” and RootsMagic will convert it to “after” 

e. Entering a space after the modifier is optional, RootsMagic will automatically add one if it’s 

left out during data entry 

5. Date Ranges - RootsMagic will recognize the following entered text and convert it to the 

indicated range: 

a. Between/And: 

i. Enter “bet” and RootsMagic will recognize it as “Between,” but the word “and” is still 

required for it to be a recognizable date format 

ii. As long as the word “and” or “&” is inserted between the two dates, or partial dates, 

RootsMagic will recognize that it’s supposed to be in the form of “Between date1 and 

date2” 

b. From/To:  

i.  As long as the word “to” is inserted between the two dates, or partial dates, 

RootsMagic will recognize that it’s supposed to be in the form of “From date1 to date2” 

https://en.wikipedia.org/wiki/Old_Style_and_New_Style_dates
https://en.wikipedia.org/wiki/Old_Style_and_New_Style_dates
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c. A hyphen can be entered and RootsMagic will convert it to an “en” dash, which is the proper 

character to use when placed between dates 

6. Date qualifiers - RootsMagic will recognize the following entered text and convert it to the 

indicated date qualifier: 

a. Enter “abt” and RootsMagic will convert it to “about” 

b. Enter “est” or “estimate” and RootsMagic will convert it to “estimated”  

c. Enter either “cal” or “Calc” and RootsMagic will convert it to “calculated” 

d. Enter either “c” or “ca” or “cir” or “circ” and RootsMagic will convert it to “circa  

e. There aren’t standard genealogical definitions for these Date Qualifiers. Therefore, it’s 

important that each User clearly document somewhere how they are being used in their 

database. The same is true for Date Qualitative Modifiers 

Date Tools 

1. Both the Calendar and Date Calculator Tools utilize today’s Gregorian Calendar. They do not 

have the ability to switch to, or account for, the earlier Julian Calendar. When working with 

People that lived in areas and times that were using the Julian Calendar, you will need to 

account for this by “translating” the tool result to account for the differences in the Calendars. 

“Wikipedia: Adoption of the Gregorian calendar” discusses when the transition took place for 

specific areas around the world  

Description 

1. Certain functions can result in truncating or moving extra text to other places, thus the Online 

Help recommends limiting Description entries to 100 characters or less.  

a. Exporting Descriptions to a GEDCOM File, or using (Pre-RM10) Drag & Drop to move data 

between RootsMagic files will result in the Description data field being truncated when 

longer than 100 characters. 

b. Using TreeShare to transfer Descriptions to an Ancestry tree will result in the Description 

being truncated when longer than 256 characters. The remainder will be placed in a Note  

2. The text entered in the Description data field is inserted into a Sentence Template when a 

Narrative Report is created. Therefore, a final period should not be included as part of the data 

entry. The ending sentence punctuation should be included as part of the Sentence Template 

and not required in the data entry field 

Notes 

1. Notes can be added to many different items in the database.  

a. When developing a plan on how to use Notes in support of your research, time should be 

spent understanding how & where Notes can be added to the various items in the database 

and when & where they appear, or don’t appear, when outputting data to one or more of 

the options (Reports, Websites, Online Sites and/or GEDCOM Files).  

b. For an individual Person’s Profile, Notes can be added to several different areas (Person, 

Spouse, Parents, Facts, Shared Facts and Associations). Here are sample reports showing 

where each type of Note appears: 

i. Reference file: Narrative Report Note Placement Example  

ii. Reference file: Family Group Sheet Note Placement Example  

https://en.wikipedia.org/wiki/Adoption_of_the_Gregorian_calendar
https://gfo.org/file_download/inline/fa3105e6-acc4-424b-881b-33c1ebc6d55f
https://gfo.org/file_download/inline/783c4e51-1b6d-47c1-bb91-04474e2b5613
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iii. Since Notes are inserted after the sentence generated by a Fact’s Sentence Template, 

it’s possible to design a Sentence Template that does not end with a period, with the 

expectation that the Fact Type will “always” have a Note following it: 

(1) The Note would be entered with the expectation that it’s the end of the resulting 

sentence in a Narrative Report 

(2) Reminder: Footnote/Endnote superscripts will be placed at the end of the sentence 

generated by the Sentence Template and prior to the Note text 

c. Although not all are called Notes, Notes can also be added to:  

i. For Places, Place Details, Addresses and Repositories; they are called “Note”  

ii. For Sources, they are called “Source Text” and “Source Comment” 

iii. For Citations, they are called “Research Note” and “Detail Comment” 

iv. For Media Files, they are called “Description” 

v. For Tasks, they are called “Goal/Details” and “Results” 

vi. RM10 & On, For Health History, they are called “Health Note” 

vii. RM10 & On, For DNA Matches, they are called “DNA Note” 

2. Note formatting: 

a. The only formatting of Note text available is Bold, Italics and Underline.  

b. Blank lines can be inserted by using the Enter Key to insert a carriage return.  

c. Portions of Note text can be designated as Private by enclosing the text within curly “{ }” 

brackets  

d. All other formatting copy/pasted into the Note field will be lost when the Note is saved to 

the database  

e. Reminder: If using TreeShare to pass Note data to an Ancestry tree, upon receipt by 

Ancestry, extra line feeds and spaces are stripped out  

3. If a Note is opened in its own, larger Note Window; you must click on the “Save Note” Button 

to save changes. Closing the larger Note Window without saving will result in all changes 

made while in the Window being lost. 

4. When creating large Notes, you may find using an external Note Editor program (like Windows 

Notepad) more convenient than working in the larger Note Window.  

a. When done, just copy/paste the text into the Note field  

b. A key advantage of using an external Note Editor is eliminating the risk of accidentally 

closing the Note Window without clicking on the Save Note Button first, resulting in the loss 

of all edits made.  

c. Plus, you can freely navigate within RootsMagic, if necessary, rather than being forced to 

close the Note Window first 

5. There is no character limit for Notes, but each item can only have one Note 

6. While hovering over a Note field that contains data, a Popup Bubble will show a significant 

portion of the Note (~2,000 characters) without having to open up and then close the Note 

Window 

7. There are some Note editing capabilities only available via keyboard shortcuts 

8. Pre-RM9, The Replace (Ctrl+R) function listed in the RM9 Online Help does not work. This 

misleading information has been removed in the RM10 & On Online Help. 

9. URL hyperlinks inserted in a Note field, can be opened by pressing the Ctrl-Key (Cmd-key on 

Macs) and then clicking on the URL.  
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RM10 & On, MOVING OR COPYING A FACT 

1. Facts can be Moved, or Copied, by either selecting the Fact and then clicking on the Options 

Icon; or hovering over the Fact and right-clicking  

2. For Facts that have been Shared with other People: 

a. The original Fact, shared with others, can be: 

i. Moved, and all People it has been shared with are retained 

ii. Copied, but all People it has been shared with are not copied 

b. The Shared Facts assigned to People with Supporting Roles can’t be Moved or Copied using 

these tools 

3. In order to create multiple copies of a Fact for the same Person, temporarily place a copy of the 

Fact with another Person. Then: 

a. If only 1 additional copy is desired, use the Move Fact tool to move it to the original Person 

b. If multiple copies are desired, use the Copy Fact tool to repeatedly create an additional copy 

for original Person until only one more copy is needed, and then Move the last one 

FACT TYPES 

1. There are 64 built-in Fact Types, which can’t be deleted, plus 16 built-in Associations Types. The 

name or abbreviation for the built-in Fact Types and Associations Types can’t be edited.  

a. Reference file: List of the 64 built-in Fact Types and their default information 

2. When data is imported from another data source that contains Facts and Events that do not 

exactly match the built-in Fact Types, RootsMagic automatically creates a new Custom Fact and 

adds it to the Fact Type List.  

a. As a new Custom Fact Type, it will have an undefined Sentence Template.  

b. After importing data, it’s always a good practice to review the Fact Type List to see if new 

Fact Types were created that are “similar to” existing Fact Types in which case they should 

be reassigned to the existing one 

3. Reminder: A Fact Type List from another RootsMagic file can be imported (see Databases > 

Importing Lists). If a Fact Type List is imported into a file with existing Custom Fact Types, 

RootsMagic does not check for duplicates. The resulting list must be reviewed and duplicates 

cleaned up. Cleanup is best done by: 

a. Editing the name of one Fact Type to easily differentiate it from the other  

b. Decide which to keep  

c. Use the TOOLS Page > FACT TOOL > “Change Fact Type For Everyone” to change the Fact 

Type to be eliminated to the Fact Type to be kept 

4. Deciding when to create a Custom Fact: 

a. You want to capture more granularity in recorded information for searching, filtering, 

grouping, color coding, etc  

b. You want to exercise more control over Output formats and data content such as: 

i. Narrative Report sentence templates for printed vs website output 

ii. Separating Fact information to be included in output reports from information to be 

excluded 

c. You can’t modify an existing Fact Type to support what you want to record because one or 

more of the following apply: 

i. The desired change(s) would negatively impact the pre-existing uses of the Fact Type 

https://gfo.org/file_download/inline/8ff7b443-1d40-4db0-84d5-cfce0d279373
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ii. The existing Fact Type is one of the “Special Fact Types” and it makes more sense to 

address this situation by using a combination of the “Special Fact Type” and a new 

Custom Fact Type  

iii. The existing Fact Type can be modified, but you plan on using the modified version in 

multiple database files and want to be able to easily add it to new files using the FILE 

Page> IMPORT DATA > IMPORT LISTS function 

d. You decide the “Miscellaneous” Fact Type is not good enough because one or more of the 

following apply: 

i. When viewing the Person’s EDIT PERSON Window, you want to see something other 

than “Misc” in the “Facts” column to convey what the Fact is about 

ii. You expect to use it many more times and want to use a common Sentence Template 

specific to the Custom Fact 

iii. In the future, you want to be able to perform searches, apply Color Coding and/or 

create Groups based on the Custom Fact 

e. If your Custom Fact is only used once in your database, you should consider using the 

Miscellaneous Fact Type to avoid growing the Fact Type List unnecessarily 

5. Creating a new Custom Fact Type: 

a. The Fact Type List can be accessed in the following ways:  

i. PEOPLE Page > (RM11 & On) LISTS/(Pre-RM11) More Options > Fact Type List 

ii. EDIT PERSON Window > Add Fact (+ icon)  

iii. EDIT PERSON Window > Hover over area on the left > right-click > select Add New Fact 

iv. TOOLS Page > FACT TOOLS > “Add or Modify Fact Types” 

v. COMMAND PALETTE > “Fac” 

b. When naming a new Fact Type, thought should be given to where it will show up in the Fact 

Type List and how many letters must be entered in the Search Box to find and select it  

c. Caution: RootsMagic does not prevent you from re-using an existing Fact Type name, which 

would result in 2 different Fact Types with the same name 

d. When creating a Fact Type; the Date, Place and Description data fields are optional choices 

that determine whether these data fields are displayed in RootsMagic when viewing Facts 

based on the selected Fact Type  

e. If a Sentence Template is not entered when a new Fact Type is created, RootsMagic 

automatically creates one in the form of:  

i. “[NEED TO DEFINE SENTENCE: FACTTYPENAME]” 

ii. Fact Types missing a Sentence Template can be identified using the TOOLS Page > 

ENHANCED PROPERTIES LIST tool 

f. New Fact Types are only created in the currently open database file. If you have other 

database files you want to use it in, you must use the FILE Page > IMPORT DATA > IMPORT 

LISTS function to add it to your other file(s) 

6. If you edit a built-in Fact Type and you want to make the same changes in another file, because 

the IMPORT LISTS function doesn’t work on built-in Fact Types, you will need to either:  

a. Manually make the same changes in the other files  

b. Or, if the changes aren’t being made to one of the “special” Fact Types listed below, create a 

Custom Fact Type with the desired settings and use the TOOLS Page > FACT TOOLS > 
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“Change Fact Type For Everyone” tool to replace the use of the built-in Fact Type with the 

new one 

7. If a Custom Fact Type that has Facts based on it is deleted, all of the Facts based on this Fact 

Type will be deleted too, if you acknowledge the Warning.  

a. Any links to Sources, Media and/or Tasks linked to the deleted Facts will also be deleted 

from the database.  

b. However, any Sources, Media and/or Tasks that are no longer linked to other information 

will still remain in the database file and can be found in the list on their respective Pages 

8. Wildcards (_ and %) and the double quote (“) character work for Fact Type searches  

9. Several of the built-in Fact Types have “special” uses in RootsMagic. They are: 

a. Birth, Christen, Marriage, Death & Burial Fact Types are used: 

i. In standard reports that include Birth, Marriage and Death information 

ii. To calculate age - requires a date entered in a Person’s Birth or Christen Fact 

(1) Note: Some Users that have People with no Birth or Christen Fact, but have a 

Baptism Fact for the Person have decided to use the Christen Fact instead of a 

Baptism Fact and modify the Principal Sentence Template for the Christen Fact 

Type (or customize individual Facts) to state that the Person was Baptized 

iii. To automatically uncheck a Person’s “Living” checkbox – requires a Person to have: 

(1) A Death or Burial Fact  

(2) Or, a Birth or Christen Fact with a date that is at least 105 years ago 

iv. To flag Problem Alerts (red dot with exclamation point) and include them in the 

Problem List Report 

v. If more than one of these Fact Types are entered for a Person, RootsMagic may not 

properly perform the actions listed above. To avoid this, one of the Fact entries must 

be identified as the “Primary” Fact by checking the checkbox for that Fact. 

b. Primary Name Fact Type: 

i. Each Person can only have 1 Primary Name Fact and it’s automatically created when a 

Person is added to the database 

ii. It’s not available to choose from the Fact Type List 

iii. All the information about a Person’s name that is used by RootsMagic is recorded here 

iv. There is no Sentence Template for this Fact Type. The Primary Name Fact information 

can be used in all other Fact Sentence Templates defined for all other Fact Types 

assigned to the Person 

c. Alternate Name Fact Type: 

i. The data fields are the same as those for the Primary Name Fact Type 

ii. An Alternate Name Fact can be designated to become the “new” Primary Name Fact 

for a Person. This automatically makes the “previous” Primary Name Fact an Alternate 

Name Fact 

iii. Can’t be shared with other People 

iv. Can’t be used as a “Criteria” for use in Searches, Groups or Color Coding 

v. Has a Sentence Template and therefore can be included in Narrative Reports 

vi. Is treated like a Fact in standard reports 

vii. Can’t be included in Custom Reports 

d. Association: 
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i. Although Association appears in the Fact Type List, Associations are different:  

(1) Facts tend to be event-based information recorded about a Person 

(2) Associations tend to be used to record, non-event-based, Non-Family relationships 

between 2 People in the database 

ii. Pre-RM11, Can’t search for specific Association Types 

iii. Can’t be shared with additional People 

iv. Can’t be copied or moved like Facts. 

e. Reference No (Ref #): 

i. By default, this Fact Type only uses the Description and Sort Date fields 

ii. Since the RIN (Record ID Number) is not guaranteed to remain permanently assigned to 

a specific Person, the intended use of Ref # is to allow the assignment of a User-

Defined preferred/permanent numbering/coding scheme to People in the database 

iii. The Ref # can be displayed appended to the end of a Person’s name within RootsMagic 

similar to the RIN or FSID by going to SETTINGS Page > GENERAL Settings View and 

setting “Number To Display” to “REFN” 

iv. Some other possible uses are: 

(1) This RootsMagic blog article: “Memorial Day Preparations: FAN Clubs and Grave 

Neighbors” provides an example of how this Special Fact Type can be used to 

visually enhance the information about People in a database  

(2) The assignment and display of Ahnentafel numbers  

(3) Differentiate unlinked People resulting from documentary vs DNA research  

(4) A place to assign Emojis  

(5) Unlike RIN and FSID, Ref # can be transferred to an Ancestry tree as a Fact using 

TreeShare or exported in a GEDCOM File as a Fact 

f. Adoption: 

i. In addition to the Date and Place data fields, this Fact Type also has a data field called 

“Parents”. Clicking on the Parents data field presents a list of all the Parent Couples 

already identified for the Person that the Fact is being added to. 

ii. The identified Parents are not part of the default Sentence Template and there isn’t a 

way to add them since the Sentence Template Language does not define a variable for 

“Parents”. 

iii. Although disabled in the default configuration, if desired, the User can enable the 

Description data field by editing the Fact Type, allowing the [Description] Sentence 

Template Language variable to be added to the Sentence Template. 

g. LDS specific Fact Types:  

i. Used to interface with LDS specific information at FamilySearch by Church Members 

10. Sample uses of Custom Fact Types: 

a. To manage status (work completion, level of documented Facts, group membership) of 

People in the database: 

i. An example would be to track each Person’s research status based on Yvette Hoitink’s 

“Six Levels of Ancestral Profiles - Level-Up Challenge!”,. or any other defined set of 

levels and criteria for each level  

http://blog.rootsmagic.com/?p=3877
http://blog.rootsmagic.com/?p=3877
https://www.dutchgenealogy.nl/six-levels-ancestral-profiles
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b. You want to modify the default Sentence Template of a built-in Fact Type (that isn’t one of 

the “special Fact Types” listed in this Handout) and be able to replicate the changes in 

additional database files using the IMPORT LIST function 

c. You want more granularity for a Fact Type to: search, filter, group, color code, etc,  

i. An example would be creating separate “Census 1900” & “Census 1910” Fact Types 

instead of using the built-in “Census” Fact Type so that filtering can be performed for 

each different Census Fact Type 

d. Once created, these Custom Fact Types can be added as additional columns on the PEOPLE 

Page > PEOPLE List View, on the SEARCH Page > BASIC & ADVANCED Search Results, used to 

assign Color Coding, etc 

i. An example showing one User’s Census completion status grid in the People List View 

is shared in this RootsMagic Community post:  My People List View Grid, dated Oct 

2024  

ADDING ROLES 

1. In order to Share Facts, Supporting Roles must be created for the affected Fact Type.  

a. Refer to the Working With Facts > SHARING FACTS section for information on the tradeoffs 

to consider between sharing and replicating Facts with other People.  

b. Although it requires more time and effort to implement, a third option is to do both:  

i. Use Shared Facts to enhance Narrative Reports, including relocating sentences for 

Family/Couple Facts to the Individual/Person section of the Narrative Report Fact 

timeline 

ii. AND, create copies of the Fact for the same People to ensure no data will be lost in 

data exports.  

iii. To implement this option and avoid duplication in Narrative Reports: 

(1) A Supporting Role should be created that will be “shared” with the Principal. This 

Role will contain the Sentence Template to be used for the “Supporting” Principal 

Role  

(2) The Fact’s Principal Role Sentence Template should be deleted, thus preventing a 

sentence from being generated for this Role when a Narrative Report is generated 

(3) The end result is everyone involved will have 2 Facts for the same event.  

(a) One as a Supporting Role assigned from the original Fact entered for the 

Primary Person, including the Primary Person.  

(b) The second Fact is a copy of the Primary Person’s Fact, since the Principal Role 

does not have a Sentence Template for the Principal Role, all sentences will be 

generated using the assigned Supporting Role Sentence Templates 

2. When creating a Custom Fact Type, it must be created and saved before Supporting Roles can 

be added  

3. If Supporting Roles exist for a Fact, they do not have to be used 

4. You can assign a Person not in the database to a Shared Fact Supporting Role 

5. When Sharing a Fact, the list of Supporting Roles to choose from is listed in the order they were 

created, not alphabetically.  

a. When creating many Supporting Roles for a single Fact Type, advanced planning of the 

desired order to list them is recommended  

https://community.rootsmagic.com/t/my-people-list-view-grid
https://community.rootsmagic.com/t/my-people-list-view-grid
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b. In an existing list, if you want to change the order of the Supporting Role list, you must: 

i. Create new Supporting Roles for each Role currently listed above the one you want to 

be first  

ii. Switch all affected People to the newly defined Role(s). You can do this by: 

(1) RM11 & On, Make a Group of all people in the database that have the Fact Type 

shared with them 

(2) RM10, Make a Group of all People in the database that have the “Number of 

Shared Facts” > 0 

(3) Pre-RM10, Make a Group of all People that have the Fact Type containing the 

affected Supporting Role(s) 

iii. Filter the Index List to only show People in the Group just created  

iv. Open each Person’s EDIT PERSON Window and check to see if the Fact Type being 

modified has been Shared, and if so, whether the Supporting Role that is being 

changed was Shared with them 

(1) If it was Shared, change the assigned Role to the newly created one 

(2) If a Supporting Role Note was entered previously, it remains after changing the 

Role 

v. Once every Person has been checked, then delete the “old” Supporting Roles from the 

Fact Type which should result in the Supporting Roles being in the desired order  

vi. To avoid doing the above, as soon as you decide to Share Facts: 

(1) Spend time thinking through what the desired order of Supporting Roles to choose 

from should be and create the Supporting Roles in that order 

(2) If you don’t want the built-in Supporting Role (usually “Witness”) to be the default 

choice at the top, delete it and recreate it when desired 

6. Reminder: When crafting Sentence Templates for Supporting Roles: 

a. [Person] always refers to the Principal Person, even when working with a Family Fact 

b. [ThisPerson] refers to the Person assigned to a Shared Supporting Role 

c. [OtherPersons] is everyone that is assigned to any of the Shared Supporting Roles 

d. [Role] where “Role” is the Supporting “RoleName” is: 

i. Everyone assigned to the specified Shared Role when used in the Principal Sentence 

Template 

ii. Everyone assigned to the specified Shared Role, except the Person the Fact is Shared 

with. To include them as well, [ThisPerson] must also be included. 

e. [ThisPerson:Role] results in the Role Name being inserted in the sentence rather than 

ThisPerson’s Name 

f. [Field#] allows you to specify specific People’s names that have a Shared Role when more 

than one Person has been assigned the same Supporting Role. Caution must be exercised 

when using this if you’re trying to single out specific People in the template since the # is 

based on the order People are assigned the Supporting Role 

g. Only People assigned Supporting Roles that are mentioned in the Principal Sentence 

Templates are listed in the Narrative Report Name Index. This can be an import way to 

include important People that aren’t otherwise related to the family line the report is being 

generated for 

7. When adding a new Supporting Role to a Fact Type, stop and ask yourself: 
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a. Do you need to modify the Sentence Template for the Principal Role, or any other 

Supporting Role Sentence Templates for this Fact Type to include the People that get 

assigned to this new Supporting Role? 

b. Are there People in the database that you want to go back and decide whether this new 

Shared Fact Supporting Role is applicable to their Fact?  

i. If yes, you may want to make a Group of everyone currently in the database with this 

Fact Type to use as a “To Do” list of People to check now, or in the future. If doing it 

later, consider creating a Task describing what needs to be done to refresh your 

memory when you’re ready to proceed 

8. Reminder: If the Name of a Supporting Role for a Fact Type is modified, review the Sentence 

Templates for the Principal and all other Supporting Roles to see if the previous Role Name was 

used in any of the other templates. If it was used, they must be edited to match the revised 

Supporting Role Name 

CUSTOMIZING SENTENCES 

1. If the “Customize Sentence” function is used on a Person’s EDIT PERSON Window for a specific 

Fact, be aware that currently there isn’t a way in RootMagic to locate them in the future other 

than opening each Fact assigned the Fact Type in question and comparing its Fact Sentence with 

the default Fact Type Sentence Template 

2. If the Fact’s Sentence Template is deleted, you will get the same result as if the “Reset To 

Default” Button was clicked: 

a. The default Fact Type Sentence Template will be inserted 

3. Things to consider before customizing a Fact Type Sentence Template: 

a. Is the change being considered just a one-off situation, or only applicable to a few People? If 

yes: 

i. Just customize that specific Fact’s Sentence Template  

ii. Copy/paste the revised sentence format to the few other People it applies to 

iii. If you want to locate these customized Fact sentences in the future, consider making a 

list of who and which Facts were customized in a separate log file, or tag each modified 

Fact with a common Task so they can be easily found again in the future 

b. Is this change something you’ll want to apply to several People’s Facts? If yes: 

i. Consider the possibility of modifying the Fact Type Sentence Template using the 

Sentence Template Language 

ii. Or, as long as it’s not one of the “Special” Fact Types; create a similar, but different, 

Custom Fact Type allowing you to select one or the other depending on which 

Sentence Template is more appropriate for the Fact being entered.  

c. If the customization involves People the Fact is being shared with, ask yourself whether the 

changes should appear in the Sentence Template for the Principal, a particular Supporting 

Role, both or maybe a new Supporting Role needs to be created for this unique situation 

d. When customizing a Sentence Template for a Fact that has been Shared with a Person 

assigned a Supporting Role, be aware that the resulting sentence in the lower portion of the 

Window will only include [Person], if used. [Date], [Desc], [PlaceDetails] and [Place] from the 

Principal’s Fact will not be shown. To see the complete resulting sentence, click OK and view 

it in the “Sentence” area on the Person’s EDIT PERSON Window. 
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SENTENCE TEMPLATE LANGUAGE 

1. The Online Help topic “Working With Facts > Fact Sentences > Sentence Template Language” 

covers all the Template Language Data Field Names, Field Options, Formatting Codes and 

Switches that can be used along with some examples of their use 

a. The Online Help incorrectly states that the “Private Switch” can be used for Fact Sentence 

Templates. Actually, it can only be used with Source Templates. 

2. The following RootsMagic video demonstrates the creation and customization of Sentence 

Templates using an older version of RootsMagic. The User interface is different, but the details 

of how the Sentence Template Language works has not changed: 

a. “48. Sentence and Source Templates in RootsMagic”  

3. Blank lines can be inserted in a Sentence Template by adding Carriage Returns (pressing the 

Enter key) where blank lines are desired. This only works for Fact Type, not Association Type, 

Sentence Templates  

4. Reminder: Modified Sentence Templates for built-in Fact Types must be manually transferred to 

other RootsMagic database files you want to use them in. Neither the Drag & Drop, nor 

Importing Fact Type List functions will modify the default Sentence Templates of built-in Fact 

Types in the destination file. 

5. My recommended 9-step approach to crafting a Fact Type Sentence Template: 

a. When planning to create, or modify, multiple Role Templates for a Fact Type, you may find it 

easier to focus on developing one at a time, starting with the Principal Role and then moving 

to any desired Supporting Roles. This keeps the focus on a single goal which can then be 

leveraged if there are common elements in subsequent iterations to develop other Role 

Templates 

b. Reference file: “Nine Step-by-Step Examples Using the 9-Step Process”  

Step 1: Draft a sample of how you want the resulting sentence to read 

Step 2: Replace the pieces of the sentence where the specific information will come from 

one of the Fact Type Data Fields with the Data Field name 

Step 3: Confirm the needed Optional Data Fields are active for this Fact Type 

Step 4: Determine if there are additional People and/or Supporting Role names that need to 

be included in the Sentence Template. 

i. If the only other Person is the Principal’s Spouse, then the Custom Fact Type 

should be created as a Family Fact Type. Or, create as an Individual Fact Type, 

with a Supporting Role to share with the Spouse. 

ii. If People other than the Spouse are to be included, their Supporting Roles must 

be created so they can be assigned to these People and identified in the 

Sentence Template 

1. Reminder: There are a variety of Field Names when referring to People 

other than the Principal Person and sometimes they are different when 

referring to them in the Principal Sentence Template vs a Supporting Role 

Sentence Template. They are listed in the Online Help  

2. When generating a Narrative Report that includes the Principal, People 

assigned Supporting Roles and included in the Principal Sentence Template 

https://help.rootsmagic.com/RM11/sentence-template-language.html
https://www.youtube.com/watch?v=RPj-dgK5fv0
https://gfo.org/file_download/inline/cd4aa506-b997-444a-907d-9fcef436cefb
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will be included in the Narrative Report Index, even if the report does not 

include the Supporting Role Person 

iii. For each Supporting Role created, this 9-step process should be repeated to 

craft each corresponding Supporting Role Sentence Template 

Step 5: Evaluate the default verbiage that RootsMagic automatically adds to determine 

whether some Field Options need to be specified to get the desired result. 

Step 6: Determine whether, and where, conditional brackets are needed to address 

situations when one or more of the specified Data Fields are blank 

Step 7: Decide whether any Switches are needed due to different verbiage needed 

depending on a Value, Gender, Number of People or whether the Person is Living or 

not. 

i. Reminder: Switches can be “nested” inside of other switches allowing very 

powerful and flexible sentence templates to be created, when needed 

Step 8: Decide whether any text formatting is desired (Bold, Italics, All Caps, etc) 

Step 9: Trial & error testing: 

i. Reminder: “Trial & error” is part of the process of crafting the desired Sentence 

Template, as long as what is desired isn’t more sophisticated than what the 

Sentence Template Language can support 

ii. Since RootsMagic processes Templates left to right, when issues are 

encountered, work left to right through the Template to identify & correct 

issues.  

c. If there are additional Sentence Templates to develop for the Fact Type, repeat the 9-step 

process for each one 

d. Once all Templates have been developed and tested, they need to be inserted into the Fact 

Type as the default Sentence Templates for their respective Roles 

e. Lastly, ensure that the People’s Facts that were being used for Template development & 

testing by Customizing their specific Sentences have their Customized Sentence Templates 

“Reset to Default” by either clicking on the Button, or deleting the entire contents of the 

Sentence Template area 

SHARING FACTS 

1. The quandary (Pros & Cons) between using/not using Shared Facts by assigning Supporting 

Roles: 

a. For reference, “SQLite Tools for RootsMagic – Facts – Split Shared to Individual #Facttypes 

#events #sharedevent #RM9” is a technical post, whose first part discusses the “Quandary 

of Shared Events” 

b. RM10 & On, The Copy Fact tool eliminates the earlier version tradeoff of using Shared 

Facts to save data entry time & effort vs re-entering the same Fact for multiple People as a 

consideration of whether or not to use Shared Facts  

c. Use Shared Facts to create more complex narratives about People’s lives and relationships 

with others. But don’t plan on: 

https://sqlitetoolsforrootsmagic.com/facts-split-shared-to-individual/?fbclid=IwAR30EqpKaHAB_5uLkme3vqB6F-NLxjxUqaCgxwdO0g5OqL7xq5Hr7HDNZ9I
https://sqlitetoolsforrootsmagic.com/facts-split-shared-to-individual/?fbclid=IwAR30EqpKaHAB_5uLkme3vqB6F-NLxjxUqaCgxwdO0g5OqL7xq5Hr7HDNZ9I
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i. Exporting Shared Fact information to other sites and software, many of these other 

locations can’t extract the Shared Fact information contained in a RootsMagic 

generated GEDCOM File 

ii. Neither Ancestry (via TreeShare) nor FamilySearch accept Shared Facts from 

RootsMagic 

iii. Tagged Media Files and Tasks being shared with People assigned Supporting Roles 

iv. Being able to manage Shared Facts like Facts, since you can’t create reports that 

include them (other than generating Narrative Reports and exporting them to a My 

RootsMagic Website) or (Pre-RM11) search for or group them  

d. Don’t use Shared Facts when wanting to: 

i. Preserve maximum flexibility in exporting data to other sites and software 

ii. Manage them the same as all other Facts 

e. Tech Savvy Users can use external 3rd-party tools to manipulate either a RootsMagic 

database file or GEDCOM export file to try and convert Shared Facts to Individual Facts 

2. When viewing the list of Facts in a Person’s EDIT PERSON Window, the Shared Facts column: 

a. A blank entry indicates the Fact can’t be shared because it’s “special” 

b. A “-“ indicates the Fact can be shared, but has not been shared with anyone yet 

c. A number indicates the Fact has been shared with the indicated number of People 

3. When viewing a Shared Fact in a Person’s EDIT PERSON Window: 

a. The information displayed in the EDIT PERSON Window’s list of Facts is the information that 

applies to the Principal Person, not the Person assigned the Supporting Role 

i. Editing any of this data will change the information for the Principal Person, not the 

Person the Fact was shared with 

b. To view the data applicable to a Person assigned a Supporting Role (Supporting Person, 

assigned Supporting Role and their Note), view the “Shared With” List and select the Person 

4. When Sharing a Fact and assigning the same Supporting Role to more than one Person, when 

the names of People with this Supporting Role are listed, they are in the order the Supporting 

Role was assigned to each Person 

a. When a Fact is Shared with multiple People at the same time, the order in which they will be 

listed is unpredictable 

5. Reminder: When assigning a Supporting Role to a Person not in the database: 

a. You can only enter a Given name and Surname.  

i. Also, if the SETTINGS Page > GENERAL Settings View > “Surname Uppercase” checkbox is 

checked, RootsMagic DOES NOT capitalize the Surnames of People not in the database. 

If that’s your desired format for reports, you’ll need to enter the Surnames in all 

uppercase 

b. If you enter a Role Note, it will never appear in a report since these People aren’t in the 

database, there won’t be a Narrative Report entry for them, which would be the only 

location where the Note would be used 

6. If you want to switch an assigned Supporting Role from a Person in the database to someone 

not in the database or vice versa, it can’t be done by editing the existing assignment. A new 

Shared Fact entry must be created and the old assignment deleted 
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WORKING WITH PLACES 

GENERAL INFORMATION 

1. Entering Place data:  
a. Place data is entered from smallest to largest geopolitical divisions. Even if you have elected 

to display “Reverse Place Names” 
i. RootsMagic doesn’t enforce a maximum number of levels that can be entered 

(1) Reminder: If selected, PlaceClean will flag all places with more then 4 levels as 

having “Misplaced Place Details” 

ii. Specific data, like street address and/or building/cemetery name is typically entered as 
a Place Detail. Some users decide to enter it as the smallest division of the Place  

iii. Place Detail entries are specific to a Place entry. If the same Place Detail exists for more 
than one Place, it must be entered and managed separately for each Place 

b. As a Place or Place Detail is entered, RootsMagic shows up to 5 entries already in the 
database that match what has been typed so far. Selecting an entry in the displayed list: 
i. Eliminates the need to type the full Place Name 

ii. Avoids the introduction of typos, which would result in the creation of a new Place 
entry in the database containing the typo, requiring cleanup later 

c. Generally accepted practices regarding Places are: 
i. Enter the historical location name where each event occurred.  

ii. Avoid the use of abbreviations in Place names, spell everything out 
iii. Avoid the use of place division descriptors, like “county” 

d. Additional data entry topics to consider: 
i. Whether to enter foreign Place names in English, or native language 

ii. What are the proper geopolitical divisions to record in each foreign country  
e. The above aren’t “rules,” many genealogists elect to deviate from the above generally 

accepted practices.  
i. Being as consistent as possible within a database file is the most important decision 

ii. Regardless of how consistent you try to follow whatever “rules” you settle on, most 
likely exceptions will be encountered that must be recorded (for example, a city in a 
state that is not part of a county and the same state has a county with the same name 
as the city…) 

2. Management of Place data should be done from the PLACES Page, not an individual Person’s 
EDIT PERSON Window 
a. When an existing Place or Place Detail entry is modified from the PLACES Page, the change 

will be reflected in every Fact that uses it 
b. When an existing Place or Place Detail entry for a Fact is modified from the EDIT PERSON 

Window, the existing data is not modified. Instead, a new Place/Place Detail entry is created 
and stored in the database 

3. People that have Facts and Associations without a Place entry can be identified by performing a 
Rules-Based ADVANCED Search or creating a Group: 
a. Search Rules > Add A Rule >  

i. RM11 & On, Event > OK 
ii. Pre-RM11, Criteria > Edit Criteria 

b. “Any Fact” “Exists” and “Any Fact” “Place” “Is Blank” 
c. The result will be People that have at least one Fact missing a Place entry 
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d. Each Person’s EDIT PERSON Window must be opened to review their list of Facts and Source 
Citations to determine whether or not the Place is known and should be entered, or not 

4. For those using TreeShare, be aware that TreeShare does not flag differences in Place entries as 
a change needing to be TreeShared with the Ancestry Tree. Edits to Place names must be made 
directly in the Ancestry Tree 

5. For the Tech Savvy familiar with SQLite, some of the topics and scripts regarding Places found 
here may be of interest: “SQLite Tools for RootsMagic: Places – Count People and Events for a 
Group #places #statistics #events #namedgroup”  

6. For those interested in Visualizing Place Data using 3rd-Party tools, this post: “RootsMagic 
Community: Other Visualizations” discusses the use of Google Earth Pro and RootsMapper 

PLACE LIST 

1. The number shown in the “Details” column indicates the number of unique Place Details that 
exist for the Place. The number shown in the “Used” field indicates how many links to the Place 
exist in the database. 

2. When viewing a selected Place, if RootsMagic confidently recognizes it, the small map on the 
right will display a marker and the Place Name, even if it’s not currently Geocoded (lat/long 
entered). If the map remains blank, it means RootMagic can’t confidently recognize the location 
of the Place 

3. The “Standard” data field: 
a. Is typically used to identify the “Current Day” Place Name. If the Geocoding tool is used, the 

tool will populate this field with the Place Name in its Place Database File 
b. It’s not used for anything else:  

i. It can’t be used for Searches, Groups or Color Coding  
ii. It can’t be included in any reports  

iii. There isn’t a Sentence Template Language variable for it either 
4. The “Abbrev” data field: 

a. Determines what will be used as the “Shortened Place Name” when Sentence Templates 
that include “[Place:Short]” are encountered while generating a Narrative Report 

b. Application of this Field Option must be carefully planned out. When applied in a Fact Type’s 

Sentence Template: 

i. The full Place Name will only be included for the associated Fact sentence if each 
specific Fact sentence is individually customized 

ii. Or, only use the “:Short” Field Option in specific, customized, Fact Sentences; rather 
than including it in the Fact Type Sentence Template 

c. Tech Savvy Users familiar with SQLite developed an external script using 3rd-party tools that 

can modify a Person’s Fact Sentences to include the full Place Name at first occurrence and 

the Abbrev name for subsequent uses. It’s discussed here: “SQLite Tools for RootsMagic: 

Places – first name exploit for improved narratives #places #reports”  

5. The “Note” data field: 

a. The information entered as a Place Note is displayed when the “Select Place (Globe Icon)” 
tool is opened from the Place data field for a Person’s Fact or Association and a Place Name 
is selected from the list 

b. This could be used as a way to annotate the date range a particular Place Name existed 
when dealing with a location that had different Historical Place Names over time, compared 
to the current day and avoid future reminders from the CountyCheck tool 

https://sqlitetoolsforrootsmagic.com/category/places
https://sqlitetoolsforrootsmagic.com/category/places
https://community.rootsmagic.com/t/other-visualisations
https://community.rootsmagic.com/t/other-visualisations
https://www.google.com/earth/about/versions
https://rootsmapper.com/
https://sqlitetoolsforrootsmagic.com/places-first-name-exploit-for-improved-narratives/?fbclid=IwAR1fD901gAQm2gFQYcTR7hhX-koA59_wTwpsWVm1Qtm1eumZcO2UwhgB9N8
https://sqlitetoolsforrootsmagic.com/places-first-name-exploit-for-improved-narratives/?fbclid=IwAR1fD901gAQm2gFQYcTR7hhX-koA59_wTwpsWVm1Qtm1eumZcO2UwhgB9N8
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c. This could even be expanded to include Historical Place Names for before and after the 
annotated period applicable to the currently selected Place Name 

6. Media, Tasks and WebTags attached to a Place can’t be viewed from a Person’s EDIT PERSON 
Window. You must switch to the PLACES Page and select the Place to view them 

7. A new Place can be entered on the PLACES Page by either: 
a. Clicking on “ADD” 
b. Or, hovering over the Places list area, right-click and select “Add” 

8. An existing Place can be deleted from the PLACES Page by: 
a. Unless already known, it’s always a good idea to check what the Place is currently linked to 

by clicking on the “Used” field, if it’s not “0” (unused) 
b. Select the Place, then click on “DELETE” 
c. Or, Hover over the Place, right-click and select “DELETE” 
d. Pre-RM11, Or, Select the Place, then click on the “More Options (3 dots)” icon and then 

select “Delete Selected Place” 

PLACE DETAILS LIST 

1. When viewing a selected Place Detail, if RootsMagic confidently recognizes the Place, the small 

map on the right will: 

a. Display a marker along with the Place Detail and Place Name. Be aware that, unless the 

Place Detail has been geocoded, what is actually being displayed is based on just recognizing 

the Place.  

b. Remains blank, it means RootMagic can’t confidently recognize the Place associated with 

the Place Detail 

2. The following topics described above in the Place List section also apply to Place Details: 
a. Standard, Abbrev and Note data fields  
b. Media, Tasks and WebTags  

MERGING PLACES 

1. When multiple entries in the Place List are discovered that are actually the same Place, like most 

data in RootsMagic, don’t delete & re-enter the data, “Merge” the data  

2. Before performing a Merge, consider the following: 

a. Depending on the extent of the Merging to be done, consider making a Backup before 

proceeding with the Merge tool 

b. Only the “Surviving” Place Name, Standard and Abbrev data fields survive the Merge. The 

data entered in these data fields in the other selected Places will be gone 

c. If the Lat/Long data fields for the “Surviving” Place: 

i. Contain data, any Lat/Long data entered in the other selected Places will be gone.  

ii. Are blank, and there is Lat/Long data entered for the Place selected to be Merged, the 

Lat/Long data is transferred to the “Surviving” Place. 

d. When Place Notes exist: 

i. If the Place Notes are 100% identical to each other, only one copy is retained 

ii. If there are any differences, they are appended together into a single, surviving Place 

Note.  

e. All Media, Tasks and WebTags from all Places selected to be Merged are retained 

f. All Place Details from all Places selected to be Merged are retained:  
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i. If the same Place Details Name exists in more than one of the selected Places being 
Merged, they are not merged as part of a Place Merge and must be Merged using the 
“Merge Place Details” tool.  

3. Merge Places tool: 

a. The Merge Places tool can be initiated by either: 

i. Select the “Surviving” Place, then select “Merge Places” 

ii. Or, Hover over the “Surviving” Place, right-click and select “Merge Places” 

b. After Merging Places, I recommend checking: 

i. Review the resulting Note data field and cleanup Merged Notes as desired 

ii. Review the resulting Place Details for the “Surviving” Place for any duplicate (exact, or 

typos) or unused entries needing cleanup 

4. The Merge Place Details tool works the same as the Merge Places tool, except that it can only be 

initiated by clicking on Merge Place Details, right-clicking does not work for this tool 

5. Using Drag & Drop to move Everyone in the database to a new, empty, database will cause any 

Place entries that are “identical” to be merged.  

a. However, any subtle differences will result in the “similar” Places not being merged. 

b. Before attempting this, be sure to review all the known Drag & Drop data loss issues with 

performing a Drag & Drop using the version of RootsMagic being used 

MAPPING 

1. RootsMagic only displays a location marker on the Mapping View map when: 

a. Places have their Lat/Long entered or, when the Lat/Long fields are blank and RootsMagic 

has “confidence” it knows what the location is 

i. Although RootsMagic may be confident it knows what the Current Day location is, be 

aware that it’s still possible RootsMagic is wrong 

b. Place Details are only displayed when: 

i. The Lat/Long data has been entered 

ii. RootsMagic has “confidence” it knows what the Place is  

2. Navigating within the Map 

a. Location markers are labeled with the smallest geopolitical division entered for the Place 

Name 

i. Hovering over the location marker will display the full Place Name 

ii. Clicking on the marker opens a Popup Window that lists the Year, Event Name and 

Person.  

(1) The Events are listed in chronological order, based on the Fact Sort Dates, for all 

Events that occurred at that Place location 

(2) Entries with a blank Year listed above the last Date entry, have a Sort Date entered 

(3) Entries with a blank Year listed at the bottom don’t have a Date, and may not have 

a Sort Date entered 

b. You can zoom in/out by either: 

i. Using “Zoom-In”/”Zoom-Out”  

ii. Or, the mouse scroll wheel, if you have one 

c. You can move the Map to view areas not being displayed by clicking on the Map & dragging 

it to a different location within the display area 
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3. When using the “Map People (Events)”, when using the Edit Person (pencil) icon to open the 

Person’s EDIT PERSON Window, unlike when opening it from the PEOPLE Page, this Window 

must be closed before you can do anything else within RootsMagic 

GEOCODING PLACES 

1. For non-USA-based users, be aware that if your computer system language setting uses a 

decimal comma instead of a decimal point for Lat/Long entries, RootsMagic won’t recognize the 

data as Lat/Long data. The decimal commas need to be changed to periods prior to saving the 

data 

2. When Geocoding Non-USA Places, I recommend refreshing your memory by re-reading the 

“Approximating Places Not Found” portion of the Geocoding webpage found in the Online Help 

3. Geocoding Places can be performed two ways in RootsMagic:  

a. Using the built-in tools 

b. Or manually, using 3rd-party tools 

4. Geocoding Place Details must be done manually using 3rd-party tools 

5. Built-In Geocoding tools: 

a. The built-in tools rely on the internal Place Database File that is installed with the 

RootsMagic program to recognize Historical Place Names and correlate them to their 

Current Day Place (Standard) Names and Latitude and Longitude data 

i. The Place Database File is dated 2006 and has not been updated since:  

1. The “Current Day” Place Names may not be current, if the local geopolitical 

divisions have changed since the 2005/2006 time period 

2. Errors found in the data have never been corrected.  

ii. So, there’s always the low probability of an error in the information for a Place you are 

working with.  

1. I recommend becoming familiar with the history of the localities you work with so 

you can evaluate the results while using the tools to ensure they are identifying the 

correct, Current Day location for each Historical Place in the database file 

iii. Therefore: “Trust, But Verify” 

b. The “Geocode Selected Place” tool: 

i. This tool only works successfully if the selected Place appears in the small map on the 

right side  

ii. The tool can be initiated by either: 

(1) Select the Place Name, then select (RM11 & On) TOOLS/(Pre-RM11) MORE 

OPTIONS Icon >“Geocode Selected Place” 

(2) Or, hover over Place Name, then right-click and select “Geocode Selected Place” 

iii. Using this tool with a Place that has already been Geocoded will cause RootsMagic to 

attempt to Geocode the Place again.  

iv. If RootsMagic doesn’t enter Geocode data into the Standard and Lat/Long data fields, it 

means the Place’s Current Day location couldn’t be determined with “confidence” 

v. If the Place doesn’t get Geocoded and the Historical Place Name is correct, the next 

steps are to: 

https://help.rootsmagic.com/RM11/geocoding-places.html
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(1) Look up the Place Name in the Gazetteer as follows to see what the “confidence” 

scoring results are for the Places that might be the correct location but RootMagic 

didn’t have the “confidence” to make the decision on its own: 

(a) Copy the Place Name in the Name data field 

(b) Open the (RM11 & On) TOOLS/(Pre-RM11) MORE OPTIONS > “ Gazetteer” 

(c) Paste the Place Name in the Search Box 

(d) Determine if any of the listed places are the Current Day Place 

(2) Manually Geocode the Place 

c. The “Geocode All Places” tool: 

i. Places that already have Lat/Long data entered are skipped when using this tool  

ii. Since a lot of data may be modified when this tool is used, I recommend making a 

Backup before proceeding with the “Geocoding All Places” tool 

iii. After running the tool, the “Match Places” Window opens listing all Places that are not 

Geocoded: 

(1) A counter showing the number of Unmatched Places is in the upper left 

(2) As Unmatched Places in the list are selected, the Place Name is loaded in the 

Search Box and the right-side lists all the possible Current Day locations stored in 

the Place Database File that “might correspond” to the selected Place Name along 

with a “confidence” score of how close RootsMagic thinks it matches the Place 

being searched.  

(3) The list of possible Current Day Places is sorted alphabetically, grouped by 

“confidence” score 

(4) If the “correct” Current Day Place is found, select it and click the “Accept Match” 

Button. The associated Lat/Long data will be saved to the Place entry along with 

the Current Day Place Name being saved to the “Standard” data field 

(5) If not found, try modifying the Place information in the Search Box to see if the 

“correct” Current Day Place Name can be identified 

(6) If the “correct” Current Day Place Name can’t be found “with confidence”: 

(a) It’s best to leave the Place “Unmatched” by selecting it and clicking on the 

“Ignore Place” Button since: 

(i) Once a Place has Lat/Long data entered, the “Geocode All Places” tool will 

assume it’s properly Geocoded and skip it in future runs of the tool 

(ii) Manual Geocoding will need to be performed to determine the proper 

Current Day Name and Lat/Long data to record for the Place 

(b) Re-running the “Geocode All Places” tool will result in all “Ignored Places” re-

appearing in the new “Match Places” Window 

(7) When the “Close” Button is clicked, all remaining “Unmatched Places” are 

“Ignored” and the tool must be re-run to generate the latest list of “UnMatched 

Places” 

6. Manually Geocoding using 3rd-party tools: 

a. If you want to refer to the list of possible Current Day Places and “confidence” scoring that’s 

used by the built-in Geocoding tools, either: 

1. Open the “Gazetteer” tool and enter the Place Name into the Search Box one at a time 
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2. Or, run the “Geocode All Places” tool and use the “Match Places” Window that appears. 

This is probably the preferred way, if planning to work through the list one after the 

other 

b. If you just want a list of Places requiring Geocoding, plus visibility to their Place Notes: 

TOOLS Page > ENHANCED PROPERTIES LIST > “Places Not Geocoded” 

1. This list, without Place Notes, can be printed or saved to a file for reference 

c. The following steps reference using “Google Maps”: 

1. These steps are describing steps that need to be done using your preferred 3rd-party 

mapping tool(s)  

2. The 3rd-party mapping tool does not have to be “Google Maps” 

d. Manually Geocoding a Place or Place Detail requires two steps:  

Step 1: Determine the Current Day Name of the Historical Place to be Geocoded: 

i. Start by pasting the Historical Place Name into Google Maps to see if it 

recognizes what the Current Day location is 

ii. Next, try just searching for the smallest geopolitical division to see what results 

are presented 

iii. If multiple results are identified that may be the Place, switch to Wikipedia and 

FamilySearch Wiki to learn about the history of each potential Place that’s 

been identified 

iv. In order to determine the correct geopolitical divisions, turn to Wikipedia and 

the history of the local geopolitical division changes over time to confirm they 

are correct for identifying both the Historical and Current Day Place Name 

v. When the Place is in a foreign country, use the Wikipedia site available in the 

native language for the country of interest. The history of the location is more 

likely to be thoroughly explained by current local people in their native 

language:  

(1) Rely on translation tools to translate the native language text rather than 

selecting the “English” version of a website. In many cases, the “English” 

version is an abbreviated version of what is provided in the native 

language, rather than a translation  

vi. Once identified, enter the Current Day Place in the “Standard” data field, 

including the Current Day geopolitical divisions 

Step 2: Determine the Latitude and Longitude for the Current Day Place or Place Detail and 

enter it in the Lat/Long data fields: 

i. Once the Current Day Place has been determined, use Google Maps to view 

the location: 

(1) If manually recording individual cemetery burial plots, or other small 

locations not uniquely identifiable using a 3rd-party mapping tool: 

(b) You may need to determine the Lat/Long data using a handheld GPS 

device: 

(i) Similar to online 3rd party mapping tools, cell phones are typically 

accurate to ~10-30 ft 

(ii) Handheld GPS devices are typically accurate to ~10 ft 

https://www.wikipedia.org/
https://www.familysearch.org/en/wiki/Main_Page
https://www.wikipedia.org/
https://www.wikipedia.org/
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(c) Treating individual burial plots as Place Details can result in a large 

number of Place Details being created. Alternative approaches to 

consider: 

(i) Use a Place Detail to Geocode the cemetery and place the burial 

plot Lat/Long data in the individual’s Burial Fact Note 

(ii) Create a Custom Fact for Burial Plots and place the Lat/Long in the 

Fact Description 

(iii) Although not currently utilized beyond the program’s current 

mapping display and Place List Report, placing Lat/Long data 

anywhere other than the Place and Place Detail Lat/Long data 

fields will result in future versions of RootsMagic not being aware 

of these alternate locations of Lat/Long data in the database 

ii. Zoom-In as necessary, especially when Geocoding a Place Detail for a specific 

street address, building name or cemetery to locate the exact map location you 

want to use for Geocoding purposes 

iii. Right click on the screen location desired to be the Current Day Place to display 

the Lat/Long data. Clicking on the Lat/Long data copies it to the Clipboard 

iv. To add the Lat/Long to the Place or Place Detail data field: 

(1) If the Lat/Long data fields are both blank: 

(a) Paste the copied data into the “Latitude” data field. Then either: 

i. Click on the Checkmark icon, or click on another Place and the 
data will be properly split into the two data fields and saved  

ii. Or, press the Enter key, which causes the data to be split into the 
two data fields. But the data isn’t be saved until the checkmark is 
clicked or another Place is selected 

(2) If there’s existing data in one, or both, of the Lat/Long data fields: 

(a) The existing data won’t be replaced until new data is entered in the 

data field 

(b) Paste the Lat/Long data into both data fields and save it. RootsMagic 

will enter the Latitude data in the Latitude data field and the Longitude 

data in the Longitude data field 

7. To record a hyperlink that opens your default 3rd-party online mapping tool and displays the 

Geocoded location, consider the following: 

a. The Lat/Long data fields are not accessible for use within RootsMagic, except in the Place 

List Report 

b. When using Google Maps, to properly capture the Map URL click on the Share Button and 

copy the link from there.  

1. Don’t use the URL displayed for the browser webpage because it doesn’t capture 

enough Place specific information to directly open to the currently displayed location  

c. A WebTag containing the Map URL can be attached to Places, Place Details, Fact Source 

Citations and/or Persons.  

i. Reminder: WebTags are not included in any reports except the WebTag List Report 

d. The Map URL can be inserted in the appropriate Fact Note (i.e. Burial Fact for cemetery plot 

locations) so it can be included in Narrative Reports 
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i. A Map URL placed in a Note, inside curly brackets, is flagged as Private Note Data and 

will only be included in reports if Private Data is selected to be included when the 

report is generated 

ii. Reminder: URLs contained in Notes can be opened by pressing the Ctrl-key (Cmd-key 

on Macs) and clicking on the URL 

8. To create a list of all Places NOT Geocoded, run the TOOLS Page > ENHANCED PROPERTIES LIST 

tool and locate the “Places Not Geocoded” entry, then click on “View” 

9. A list of Place Details that are currently NOT Geocoded can’t be created. The only way to check 

the Geocoding status of Place Details is to view each Place’s Place Details list on the PLACES 

Page  

SPLITTING A PLACE 

1. When the “Split Place” tool is used and the resulting Place and Place Details already exist, you’ll 

end up with a duplicate Place Detail for the Place. Each Place Detail will be used by the items 

that tagged to it prior to using the “Split Place” tool. The duplicate Place Details will need to be 

merged together using the “Merge Place Details” tool 

2. There isn’t a built-in tool to perform the reverse (merge a Place Detail with a Place).  

a. A Tech Savvy User developed an external script using 3rd-party tools that can perform this 

outside of RootsMagic: “SQLite Tools for RootsMagic: Places – Conversion of Place Details to 

Places #places #placedetails #update”  

GAZETTEER 

1. The Gazetteer uses the same Place Database File used for Geocoding.  

a. The file is dated 2006.  

b. No updates or corrections have been issued  

c. I recommend becoming familiar with the history of localities you work with so results can be 

evaluated to ensure they are identifying the correct, Current Day Place geopolitical divisions 

for the Historical Place searched for in the Gazetteer 

2. The Gazetteer can be accessed four ways: 

a. On the PLACES Page > PLACE LIST View > (RM11 & On) TOOL/(Pre-RM11) MORE OPTIONS (3 

dots) Icon and select Gazetteer 

b. Or, open it from the TOOLS Page > PLACE TOOLS > Gazetteer 

c. Or, when entering a Place for a Fact or Association, clicking on the Place data field displays a 

small Gazetteer icon (magnifying glass with a map) at the far right of the data field  

d. Or, COMMAND PALETTE Icon > “gaz” 

3. As a Place Name is entered in the Search Box, the list and “confidence” scores appear below. 

The list updates as the Place Name is entered with the possible Current Day Names and their 

“confidence” scores  

4. After selecting a Place from the list: 

a. Clicking on the VIEW ONLINE Button opens up “Bing Maps” in the default browser and 

displays the selected Place 

b. Clicking on the PASTE TO PLACE Button while on the PLACES or TOOLS Page does nothing. 

However, when on a Person’s EDIT PERSON Window, entering a Fact or Association, clicking 

this Button will enter the selected Place into the Place data field 

https://sqlitetoolsforrootsmagic.com/places-conversion-of-place-details-to-places/?fbclid=IwY2xjawMBlSZleHRuA2FlbQIxMABicmlkETFGSDFtQXpsN0MzRHZYRjlBAR4NR97K1TZMlHEBgZN5GSo5mCWsPDdPrq_NYYm8U84ldJY_2VQnXXt8usyl8A_aem_Hiq4ywJKpSn-xad3rwpthw
https://sqlitetoolsforrootsmagic.com/places-conversion-of-place-details-to-places/?fbclid=IwY2xjawMBlSZleHRuA2FlbQIxMABicmlkETFGSDFtQXpsN0MzRHZYRjlBAR4NR97K1TZMlHEBgZN5GSo5mCWsPDdPrq_NYYm8U84ldJY_2VQnXXt8usyl8A_aem_Hiq4ywJKpSn-xad3rwpthw
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COUNTY CHECK 

1. Although introduced with the release of v5 in 2011, I believe the same Place Database File used 

for the Geocoding and Gazetteer tools, dated 2006, is also used for the CountyCheck Explorer 

tool.  

a. No updates or corrections have been issued  

b. Any geopolitical division changes that have occurred after the 2005/6 timeframe will not be 

identified  

c. When recording Facts/Events that occurred in 2005, or later, CountyCheck can’t be relied on 

to perform an accurate assessment of the geopolitical divisions entered for the Place. 

Additional historical research may be necessary   

2. Reminder: 

a. CountyCheck only evaluates the Historical geopolitical divisions down to the County (third) 

level 

b. CountyCheck only works for locations in the United States, United Kingdom, Canada and 

Australia 

c. Over the years, a few errors have been identified, which as I’ve mentioned have not been 

corrected with an update to the Place Database File 

3. The CountyCheck Explorer can be initiated by either: 

a. On the PLACES Page > PLACE LIST > (RM11 & On) TOOLS/(Pre-RM11) MORE OPTIONS (3 

dots) icon and select CountyCheck Explorer 

b. Or, from the TOOLS Page > PLACE TOOLS > CountyCheck 

4. The COUNTYCHECK EXPLORER Window Search Box:  

a. Only provides a list of possible Places AFTER the complete geopolitical division has been 

entered.  

b. If more than one division is entered, CountyCheck evaluates each division entry separately 

and together. It returns a list of possible Places that contain one or more of the divisions 

being searched: 

i. Common location abbreviations are recognized 

ii. Alternative names of some locations are recognized 

iii. Even though only Places down to the third level are supported, if more than three 

levels are entered in the search, each separately entered division is still evaluated as a 

possible level 1 to 3 division 

5. COUNTYCHECK EXPLORER Window data provided for each listed Place: 

a. Place: Possible result based on Search entry 

b. Type: Division level of selected Place 

c. < & > icons: Used to navigate back and forth through the history of Places viewed in 

CountyCheck 

d. Created: Date selected Place was established 

e. From: What division the selected Place was created from  

f. Contributed To: Indicates what divisions were created from the selected Place  

g. Eliminated: Indicates when the selected Place ceased to exist  

h. Known As tab: Lists in chronological order what the selected Place was called over time, 

what type of Place it was and from and to what dates 

i. Belongs To tab: Lists what the selected Place’s next higher division is 
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j. Contains tab: Lists what divisions make up the selected Place, what Type of division it was 

and from and to what dates 

k. Info Button: Opens the FamilySearch Wiki page for the currently selected Place in the 

default web browser 

l. Map Button: Opens one of several different websites in the default web browser to view 

map data for the selected Place. I’ve seen links to: Newberry Library, Wikipedia and 

FamilySearch Map of English Jurisdictions 

6. CountyCheck can also be activated to evaluate Place Names based on the event date as they are 

about to be saved while entering Facts and Associations in a Person’s EDIT PERSON Window: 

a. To activate: SETTINGS Page > PROGRAM Settings View > “Use CountyCheck When Entering 

Places” checkbox  

b. The 1st three divisions of Fact or Association Place Name entry are evaluated based on the 

Event Date, as it’s about to be saved  

c. When CountyCheck believes there may be an issue with the Place Name about to be saved, 

the COUNTYCHECK SUGGESTION Window opens 

d. Recommended changes identified by CountyCheck are presented for consideration prior to 

saving the Place Name 

e. Additional information can be viewed by selecting a suggestion and clicking on the MORE 

INFO Button, or clicking on the hyperlink for one of the divisions to open the COUNTYCHECK 

VIEWER Window which is similar to the COUNTYCHECK EXPLORER Window, without the 

search capability 

f. The decision to keep the original Place Name as entered, or accept the recommended 

change, is always left to the User 

UNUSED PLACES 

1. When “Show Unused Places” has been selected, all Places listed and any Place Details that exist 

for the listed Places are not used anywhere in the database file and can be safely deleted, if 

desired 

2. If many unused Places are going to be deleted, it may be a good time to run the TOOLS Page > 

DATABASE TOOLS > “Compact Database” tool 

3. RM10 & On, Multiple unused Places can be deleted at one time from: TOOLS Page > OTHER 

TOOLS > ENHANCED PROPERTIES LIST > PLACES: UNUSED PLACES > “View” 

4. Pre-RM10, Unused Places must be deleted one at a time 

5. Place List Report: 

a. The Place List Report can be generated from: 

i. PLACES Page > PLACE LIST View > (RM11 & On) TOOLS/(Pre-RM11) MORE OPTIONS (3 

dots) Icon > Print Places  

ii. The PUBLISH Page > ALL REPORTS AND CHARTS > Place List  

b. The Unused Places List can only be generated from the Enhanced Properties List: 

i. TOOLS Page > OTHER TOOLS > ENHANCED PROPERTIES LIST > PLACES: UNUSED PLACES 

> “View” 

ii. There isn’t a capability to generate a list of Unused Place Details since all Unused Places 

only have Unused Place Details associated with them 
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WORKING WITH SOURCES 

GENERAL INFORMATION 
1. This document contains a compilation of general “Genealogy Source Citation Reference 

Materials” collected over the years  

2. This document “Working With Sources - User Decision Worksheet” can assist the User in 

identifying key topics necessary to address in order to define the User’s approach to 

implementing Source Citations in RootsMagic  

3. Refer to the User Decision Worksheet for Decisions #1 & #2 

 

4. This diagram summarizes the interdependencies between People, their Facts, the creation 

and linking of Source Citations, inclusion of Source Citations in Published reports and 

considerations when exchanging Source Citation data externally:  

1. People: First, you need a Person already created in the database file 
2. Person, Family (Couples), Facts, Associations, Name (Primary & Alternate) 

and/or Tasks: With the exception of Tasks, all of these items are created for a 
specific Person in the database file. Source Citations are attached to one, or 
more of these items for one, or more, People or Tasks in the database file 

3. Does Source Exist? When attaching a Source Citation, you either select one that 
already exists, or create a new one 

4. Select Source Type: The first step in creating a new Source is to select the 
Source Type. The Source Type defines the data fields to be used for data entry 
and how will be used to create the resulting Source Citations: 

5. Source Data Set: Is made up of 2 Parts called Master Source & Master Source 
text, media, etc. 

https://gfo.org/file_download/inline/ad6229c9-c233-4e47-ae41-ffbc2f04688d
https://gfo.org/file_download/inline/ad6229c9-c233-4e47-ae41-ffbc2f04688d
https://gfo.org/file_download/inline/0f415287-9faf-48ed-88b5-db7b82ea4db1
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6. Citation Data Set: Is also made of up 2 Parts called Citation Details & Citation 
Detail text, media, etc. 

7. When the Source exists already (The “Yes” path from Decision block #3): You 
select the existing Source Data Set. Then you either create a new or select an 
existing Citation Data Set or  

8. Extreme Lumper vs Extreme Splitter: As you define your approach to creating 
Source Citations, you’ll be able to determine where you fall on the spectrum of 
RootsMagic “Splitters” vs “Lumpers” 

9. Once saved to the database file, you can access and edit the data for: 
- People – you access Facts from the People 
- Sources – you access Citations from the Sources 
- User created Source Types 

10. Publish: The reports that include Source Citation data, mostly in the form of 

Footnotes/Endnotes are listed 

11. External Data Interfaces to Consider: These interfaces and how they work may 

influence your approach to using Source Citations in RootsMagic 

5. Caution: Be careful when naming Sources and Citations. RootsMagic will allow 2 different 

Sources and/or Citations with the same name to be created  

6. For those using TreeShare:  

a. Be aware that Ancestry records that are attached to the Ancestry tree and then added 

to RootsMagic by TreeShare and Ancestry WebHint records attached to RootsMagic and 

TreeShared to the Ancestry tree are linked to each other using an AncestryID.  

i. If you modify the Source Citation in RootsMagic, the changes are not passed back to 

the Ancestry tree because the AncestryID has not changed and still “points” to the 

Ancestry record, which will still be used in the Ancestry tree 

ii. If you modify the Citation in the Ancestry tree, the changes are not passed back to 

RootsMagic because the AncestryID has not changed and still “points” to the 

Ancestry record 

b. If you make changes to Source Citations in RootsMagic from the EDIT PERSON Window, 

they will be flagged in TreeShare as a change to be reconciled 

c. If you make changes to Source Citations in RootsMagic from the SOURCES Page, similar 

to Places, they won’t be flagged as changes in TreeShare.  

SOURCE LIST 
1. Refer to User Decision Worksheet decision #3 

2. The number shown in the “Citations” column indicates the number of unique Citations that 
exist for the Source. The number shown in the “Used” field indicates how many links to the 
Source exist in the database. 

3. Clicking on a row, in the Citations column, opens the Citation List for the selected Source 

ADDING A SOURCE 
1. Refer to User Decision Worksheet decisions #4, #5 & #6 

2. A Sources can be added from: 

a. The SOURCES Page by clicking on Add in the Menu Bar or right-clicking and selecting 

Add while hovering over the main window area 
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b. The EDIT PERSON Window by clicking on the Source cell for the Fact, or the Sources data 

field on the right side or (RM11 & On) the EDIT PERSON Window > Sources Page 

3. When searching for an appropriate Source Type: 

a. The key word text entered into the Search Box is used to search both the Source Type 

Name and Description.  

b. To get best results it is recommended that you only search for single words and perform 

multiple searches if you have more than one term that may apply  

EDITING A SOURCE 
1. Refer to User Decision Worksheet decision #7 

2. Changes made to a Source will appear everywhere the Source is Used 

3. It is recommended that regular Source maintenance be performed from the SOURCES Page, 

where all Sources in the database file can be viewed 

4. Sources can be edited from: 

a. The SOURCES Page by selecting the Source and editing the data displayed on the right 

b. The EDIT PERSON Window by clicking on the Source cell for the Fact, or the Sources data 

field on the right side or (RM11 & On) the EDIT PERSON Window > Sources Page 

5. A Source can be copied from the SOURCES Page by: 

a. Select the Source, select Tools > Copy Selected Source from the Menu Bar; or hover over 

the Source, right-click and select Copy Selected Source, then click OK 

b. The new copy has “(copy) added to the Source Name and no Citations are created as 

part of creating the copy 

c. The feature is useful when it is desired to create a slightly different Source by editing a 

copy the original 

CITATION LIST 
1. Refer to User Decision Worksheet decision #8 

ADDING A CITATION 
1. Refer to User Decision Worksheet decisions #9 & #10 

2. A Citation can be added from: 

a. The SOURCES Page while viewing the Citation List for a specific Source by clicking on 

Add in the Menu Bar or right-clicking and selecting Add while hovering over the main 

window area 

i. When done from here, the Citation isn’t linked to anything  

b. The EDIT PERSON Window by clicking on the Source cell for the Fact, or the Sources data 

field on the right side or (RM11 & On) the EDIT PERSON Window > Sources Page 

3. The “Add This Citation to Multiple People” tool is located on the Citation List menu Bar 

under Tools. It: 

a. Allows you to add the selected Citation to all the people you select using the 

ROOTSMAGIC EXPLORER Window that opens when the tool is selected  

b. Be aware that this tool only attaches the selected Citation to the Person (General) entry 

on the Person’s EDIT PERSON Window. It cannot attach Citations to Facts, etc 

  



GFO RootsMagic SIG Handout 

Page 67 of 84 2 March 2026 

EDITING A CITATION 
1. Changes made to a Citation will appear everywhere the Source is “Reused.” Prior to editing 

the Citation, it is recommended to: 

a. Confirm whether or not the Citation is “Reused” (the Used data field is greater than “1”)  

b. If it is “Reused” determine whether the changes apply to all uses of the Citation 

c. If not, a copy of the Citation should be made so the old version and the changed version 

can be attached to the appropriate items in the database 

2. When making edits to the Citation Details portion of a Citation, you can observe how the 

changes affect the resulting Source Citations in the lower right portion of the Citation data 

area. If you don’t see the changes as they are made, its an indication that the Citation was 

previously Customized 

3. Citations can be edited from: 

a. The SOURCES Page by selecting the Source, switching to its Citation List, selecting the 

Citation and editing the data displayed on the right 

b. The EDIT PERSON Window by clicking on the Source cell for the Fact, or the Sources data 

field on the right side or (RM11 & On) the EDIT PERSON Window > Sources Page; then 

selecting the Citation from the Citation List and editing the data displayed on the right 

4. A Citation can be copied from: 

a. The EDIT PERSON Window by: 

i. Selecting the Citation, then click on the Copy (Memorize) icon 

ii. While viewing the Source Citation list for the item you want to add the Citation to, 

click on the Paste Citation icon: 

1. Select Make Copy if you want to create an identical copy of the original Citation 

(normally with the intent to edit it slightly) 

2. Select Reuse if you want to attach the same Citation to an additional item in the 

database 

b. The SOURCES Page (only recommended if the plan is to create multiple copies that will 

all be edited prior to attaching them to items in the database) by: 

i.  Hovering over the Citation in the Citation List, right-click and select Copy Selected 

Citation 

ii. Or selecting the Citation from the Citation List and then clicking on the Copy 

(Memorize) icon, or click on Tools > Copy Selected Citation on Menu Bar  

iii. When the Copy (Memorize) icon is used, the copied Citation resides in memory and 

can be applied as a copied or reused Citation anywhere it can be “Pasted.” The 

other 2 methods add the copy to the Citation List 

c. When an item has more than one Citation attached to it, you can modify the order they 

are listed: 

i. Normally, Citations are listed in the order they were attached to the item 

ii. The order can be modified from the EDIT PERSON Window > Sources Page: 

1. Click on the “All Citations” list box and select the Event with Citations to be re-

ordered 

2. Click on the Rearrange Citations (Up/Down Arrows) icon  

3. Rearrange the listed Citations 
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CITATION QUALITY 
1. Refer to User Decision Worksheet decisions #11 

USING SOURCES AND CITATIONS 
1. Refer to User Decision Worksheet decisions #12 thru #17 

MERGING SOURCES AND CITATIONS 
1. When using the Merge All Duplicate Sources (or Citations) tool: 

a. Make a Backup file before proceeding  

b. RootsMagic only compares the text entered in the data fields.  

c. The text entered must be 100% identical (no typos, extra spaces, etc) in order for it to 

be considered a duplicate 

d. The tools are case insensitive 

e. The tool DOES NOT evaluate the links to Media files, Repositories or WebTags when 

identifying duplicates 

i. If using TreeShare to add Ancestry records to RootsMagic: 

1. Be aware that some record collections at Ancestry have Citations with 100% 

identical text, but links to different media files or 3rd party website URLs (like 

Find-a-Grave) 

2. It is recommended that you review and edit the Citation Names for these 

Citations prior to any attempt to use the Merge All Duplicate Citations tool 

f. RM10.0.4 & On, Citations with all blank data fields, including Citation Name are no 

longer merged 

g. If running both tools, run the Merge All Duplicate Sources Tool first since it may create 

new duplicate Citations 

2. When manually merging Sources or Citations: 

a. The comparison window only displays the Name and the Source Citations  

b. The data entered in the Master Source/Citation Detail text, media, etc sections is not 

displayed and therefore must be viewed prior to using the tool if there are concerns 

that the data may be different 

c. The links to Media, Repositories and WebTags are combined in the merged result 

STYLE GUIDES 
1. Refer to User Decision Worksheet decisions #18 

2. The style guide references found in the built-in Source Templates are based on the following 

publication editions: 

a. AQS - Elizabeth Shown Mills' QuickSheet: Citing Ancestry.com Databases & Images (1st 

edition, 2009) 

b. CYS - Richard S. Lackey's Cite Your Sources (1985) 

c. E! - Elizabeth Shown Mills' Evidence! Citation and Analysis for the Family Historian 

(1997) 

d. EE - Elizabeth Shown Mills' Evidence Explained: Citing Family History Sources from 

Artifacts to Cyberspace (1st edition, 2007) 

e. QC - QuickCheck Model, part of Elizabeth Shown Mills' Evidence Explained (1st edition, 

2007) 
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f. QS - Elizabeth Shown Mills' QuickSheet: Citing Online Historical Resources Evidence! 

Style (1st edition, 2007) 

SOURCE TEMPLATES 
1. Refer to User Decision Worksheet decisions #19, #20 & #21 

2. The built-in Source Templates have not been modified or updated since their initial inclusion 

in RootsMagic v4, released in 2009 

a. Starting with the 4th edition of Evidence Explained, some of the built-in Source 

Templates based on EE ARE NOT fully compliant with the new guidance 

3. There isn’t a way to search for all the Sources that use the same Source Template 

4. RM8 & On, A “Long Hint” can be defined in a Source Template for a Source Type, but the “?” 

indicating one is present is not displayed when viewing the data entry fields  

5. The following Source Templates have errors in them that may result in data not appearing in 

the listed Source Citations: 

a. Book, Audio - Footnote 

b. Census, Canada (index, published) - Footnote 

c. Church Issued Certificates (collection) - Footnote & Bibliography 

d. Church Issued Certificates (family collection) - Footnote & Bibliography 

e. Church Issued Certificates (single item) - Footnote & Bibliography 

f. Estray (Ranger) Books, parties not identified (local or county) – Short Footnote 

g. Frakturs (certificate) (single item) – Footnote & Bibliography 

h. NA-LAC (Canada) LAC Microfilm - Bibliography 

i. Passenger Lists, Ship Image (online) - Footnote 

j. Podcasts – Short Footnote 

CREATING A SOURCE TEMPLATE 
1. If you create a Source Template to use instead of a built-in Source Template, make sure the 

Name assigned will ensure that the “correct” one is selected when adding new Sources since 

you cannot merge Source Templates and you cannot delete or rename built-in Templates 

2. Many users add a special character to the Template Name so they sort to the top of the 

Source Template List and are easily found when selecting a Source Type when adding a new 

Source 

3. If you want to include a Person’s Name in the Source Template, you cannot use the pre-

defined [Person] variable used in Fact Sentence Templates. You must identify a data field in 

the Source Template where the Person’s Name must be entered in order to use it in the 

Source Citation 

4. Source Templates created with all Master Source data in proper sequence “to the left” and 

all Citation Details data in proper sequence “to the right” and all Citation section non-

Sentence Template Language text within Conditional Brackets (< & >) won’t get garbled 

when transferred through the interfaces with Ancestry TreeShare, FamilySearch and 

GEDCOM files  

5. To be added later: Clarify when existing Sources need to be ”touched” when User created 

Source Templates are modified later 
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USING A SOURCE TEMPLATE 
1. When Source Citations are transferred into RootsMagic through the interfaces with Ancestry 

TreeShare, FamilySearch and/or GEDCOM files, the data is saved as Sources using the 

following Source Types: 

a. Free Form – All FamilySearch and GEDCOM Source Citations, plus Ancestry TreeShare 

Sources not based on attached Ancestry records (appear as “Other Sources” in Ancestry 

tree) 

b. Ancestry Record – All Ancestry TreeShare Souces based on attached Ancestry records 

c. Ancestry Member Tree - All Ancestry TreeShare Sources based on Public Ancestry trees 

2. When Source Citations created in RootsMagic are transferred through the interfaces with 

Ancestry TreeShare, FamilySearch and/or GEDCOM files, the following occurs: 

a. To be added later 

b. When a GEDCOM file is created and “Extra Details (RM Specific)” is included, Source 

Citation data is included two ways. Per the GEDCOM spec as described above AND the 

corresponding RootsMagic Source Templates, Master Source and Citation Details data.  

i. If the destination site/software recognizes the RootsMagic specific data, it can 

recreate the Source Citations as originally created in RootsMagic 

ii. If the destination site/software doesn’t recognize the RootsMagic specific data, it 

will result in Source Citations as described for GEDCOM files without RootsMagic 

specific data 

3. When performing Drag & Drop operations between RootsMagic files and the data contains 

Source Citations based on User created Source Templates: 

a. RootsMagic DOES NOT check to see if the Source Template already exists and always 

creates a new copy of the User created Source Template in the destination file  

b. It is therefore important to remember to: 

i. Clean up Sources using duplicate Source Templates  

ii. Delete the duplicate Source Templates to prevent selecting the wrong Template in 

the future when adding new Sources 

SOURCE TEMPLATE LANGUAGE 
1. The Source Template Language shares a lot of commonalities with the Sentence Template 

Language addressed in the Working With Fact section: 

a. The pre-defined fields specific to Fact Sentence Templates DO NOT work in a Source 

Template. If needed, similar data fields must be defined as part of the specific Source 

Template 

b. Switches specific to a Person’s attributes (Gender, Living, Plural) DO NOT work within a 

Source Template 

c. The Source Template Language specific elements are: 

i. All Source data field and their Names must be defined as part of each Source 

Template 

ii. The Private Switch (!) 

iii. Abbreviation Options, separated by “||” 

2. Source Citation specific examples of how to apply the Source Template Language can be 

found in the Creating a Source Template and Using a Source Template sections of the Online 

Help 
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3. My recommended X-step approach to crafting a Source Citation (Footnote, Short Footnote 

& Bibliography) Sentence Templates: 

a. To be provided later 

USER SOURCE TEMPLATES 
1. User created Source Templates can be exported to individual Template files from the Source 

Template List window 

2. Individual exported Source Template files can be imported into a RootsMagic database file 

from the Source Template List window 

3. Reminder: Single or Multiple Source Templates can be directly imported from one 

RootsMagic file to another from FILE Page > Import Data > Import Lists 

4. Access to all User created Source Templates that have been shared so other Users can use 

them are posted in the “User Source Templates” section of the Online Help. Information on 

how to submit your own User created Templates to share with other Users is also provided 
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REPORTS AND CHARTS 

REPORT VIEWER 

REPORT SETTINGS 

1. Source Options: 

a. Endnotes – In reports, where Endnotes is selected, all “Reused Citations” will have a single 

Endnote, but Citations that are identical copies will have separate Endnote entries.  

CHARTS (LARGE FORMAT) 

CHARTS (REPORTS) 

1. Relationship Chart: 

a. RM11 & On, When more than 1 relationship exists between 2 People, a chart for each 

relationship can be generated from the Relationship Calculator tool  

FORM REPORT 

1. RM10 & On, Leeds Method Report: 

a. The colored boxes in the report with the filled-in black dot are the Matches initially assigned 

that color 

b. When the report is saved to an Excel file, the colors are not included, but the filled-in and 

non-filled-in dots are included. 

c. When the report is saved to a CSV file, the colors are not included, but the filled-in and non-

filled-in dots are represented by character strings, which will need to be replaced with a 

more recognizable symbol after importing into the destination software.  

LABELS 

LIST REPORTS 

1. CountyCheck List:  

a. CountyCheck only evaluates the 1st three divisions of a Place Name 

b. This report is organized by Person and the Places used in their Facts; it’s not a list that can 

be sorted by Place Name 

c. When “Everyone” is included, the report can take a long time to generate 

d. When included, the Matches option lists not just Places needing minor corrections, it also 

includes Places that require no correction 

2. RM10 & On, DNA Kinship List: 

a. If relationship links have been added between People after initial entry of the People with 

DNA Matches to be included in the report, updating the Tree Relationship for each DNA 

Match that currently does not have a Tree Relationship should be done first in order to 

ensure the latest known information is reflected in the report. 

b. “Has DNA Match” checkbox: When this checkbox is checked, the report will include People 

that have a DNA Match with the selected Person. Unchecked, it will exclude People with 

DNA Matches 
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c. ”No DNA Match” checkbox: When this checkbox is checked, the report will include People 

that don’t have a DNA Match, but do have a Tree Relationship. Unchecked, it will exclude 

everyone that doesn’t have a DNA Match 
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TOOLS  

MERGING DUPLICATE PEOPLE 

PROBLEM SEARCH 

DATACLEAN 

1. The DataClean tools can make changes to multiple entries in the database. It’s recommended 

that a Backup File be made prior to running these tools in case the results are not what is 

expected 

2. The DataClean tools only make changes that have been “Approved” by the User. It’s up to you 

to decide whether to review each proposed change, or have RootsMagic make all changes 

without reviewing each one.  

NameClean 

PlaceClean 

1. Using accurate, properly spelled and consistent Place Names is a key housekeeping task that 

helps reduce having multiple Place Names for the same Historical Place in the database resulting 

from: 

a. Merging of duplicate People with the same Facts but differences in the Place data field 

b. Typos and other data entry errors introduced by not selecting an existing entry from the 

Place List suggestions while entering Facts 

c. Importing data from other sites or files that used different Place naming conventions 

2. PlaceClean can be initiated from: 

a. The PLACES Page > PLACE LIST View > (RM11 & On) TOOLS/(Pre-RM11) MORE OPTIONS (3 

dots) Icon and selecting “PlaceClean”.  

b. It can also be initiated by selecting the “DataClean” tool from these locations: 

i. On the PEOPLE Page > Any View > TOOLS > DataClean 

ii. On the TOOLS Page > OTHER TOOLS > DataClean 

iii. COMMAND PALETTE > ”dat” 

3. The PlaceClean tool always runs on all the Places in the database file 

4. The tool options are: 

a. Problem – Select as many, or as few Problems you want the tool to flag when it’s run 

i. Misplaced Place Details: This option examines Place Names for a variety of signs that the 

smallest division in the Place Name should be a Place Detail instead. Some of the criteria 

it looks for are: 

(1) Are key words, like: cemetery, hospital, etc present? 

(2) Do the names of the first 3 divisions align with the Place Database that CountyCheck 

and/or the Gazetteer use? 

(3) Does the Place Name exceed 4 levels of divisions? 

(4) Each time the tool is run with this option selected, it may continue to suggest 

moving the smallest division level to a new Place Detail. Each time it’s run, it only 

suggests moving the current smallest division to a Place Detail entry. Careful 

consideration must be made if moving a 2nd division of the same original Place 
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Name to a new, 2nd, Place Detail entry since the 1st & 2nd suggested Place Details 

were created from the original same Place Name entry and didn’t originally 

represent two different locations 

b. Add or Remove Country – Allows the modification of a specific country name entry each 

time the tool is run. Although “United States” & “USA” are pre-entered, any Country Name 

can be entered 

i. If you’re adding a Country Name to Places and also use the Misplaced Place Details 

problem criteria, you’ll need to re-run the PlaceName tool with the Misplaced Place 

Details option selected to review Places that it flags to create a suggested Place Detail 

as a result of adding the Country Name 

c. Replace <Brackets> - Allows the modification of a specific section of a Place Name enclosed 

in brackets with other text 

d. After the tool is run, the above settings are saved for the next time it’s run. Therefore, 

always review these settings before running the tool 

5. The tool results appear as follows: 

a. 4 Columns: 

i. Empty Checkboxes – Only rows that get checked (“approved”) will be changed: 

(1) The “conservative approach” is to leave all boxes unchecked and, one-by-one, 

review and verify each suggested change to ensure they are “approved” before 

checking the boxes one-by-one  

(2) The “fast, but risky, approach” is to start by checking (“approve”) all the boxes and 

“try to be rigorous” in evaluating the suggested changes and unchecking those few 

boxes where you don’t want to make the suggested change (“disapproved”), which 

can be faster, but prone to skipping a suggestion 

ii. Original Place Name – This shows the “Current” Place Name entered in the database 

iii. Cleaned Place Name – This shows the “Suggested” Place Name after it has been 

“Cleaned” 

iv. Cleaned Place Details - This shows the suggested new Place Details entry that will be 

created as a result of “cleaning” the identified “Misplaced Place Detail” 

(1) Any Place Name that has more than 4 levels of geopolitical divisions will be 

identified as having a “Misplaced Place Detail” and PlaceClean will suggest moving 

the 5th (and lower) divisions to the Place Details data field 

b. Below the list of suggested changes are the 3 data fields for the selected Place. The 

suggested “Cleaned Place” and “Cleaned Place Details” data fields can be edited to 

something other than what was suggested by the PlaceClean tool 

c. At the bottom of the Window, the “Problems to Fix” area lists the types of Problems the tool 

has identified for the selected Place  

i. Any listed Problem can be unselected to see what the suggested Cleaned Place Name 

would be if that type of Problem is removed from consideration 

d. Make sure the checkbox of each reviewed Place “approved” to be changed is checked; and 

unchecked for each Place “not approved” to be changed before proceeding 

i. Remember, PlaceClean is making suggestions. It’s up to you to decide whether the 

suggested change is appropriate 
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e. If Place Detail Names are being created, it’s recommended that the Places they are being 

added to are noted so they can be checked for duplicate Place Detail Names after running 

the tool 

f. To make the selected changes, click on the “Clean Checked Places” Button 

6. The PlaceClean tool does not check for duplicate Place or Place Detail entries when cleaning up 

Place Names.  

a. After running the PlaceClean tool, I recommend reviewing the list of Places on the PLACES 

Page for duplicate Place entries that need to be merged using the “Merge Places” tool 

b. Also, if new Place Detail Names were created, there may be duplicates that need to be 

merged using the “Merge Place Details” tool 

COUNTING TREES 

CALCULATORS 

RM11 & On, AI PROMPT BUILDER  

1. When Prompts are built for a selected Person in the database file, the data included is: 

a. Names: Given Name, Surname, Sex, Life Span (birth & death years) 

b. Events: Event Name, Date, Place Detail and Place 

c. Spouses, Children, Parents and Siblings: Relationship, Given Name, Surname and Life Span 
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ONLINE FEATURES 

MYROOTSMAGIC 

HTML WEBSITE 

ANCESTRY TREESHARE 

FAMILYSEARCH 

1. FamilySearch Person Tools 

a. Share Data With FamilySearch: 

i. RM10 & On, When they exist, a Matched Person’s FamilySearch “Brief Life History” can 

be shared with the Person in the RootsMagic database file.  

(1) When brought into the database, the information is placed in a “Life Sketch” Fact  

(2) The 1st time a Life Sketch Fact is added to the database, a new, Custom Fact Type 

(Life Sketch) is added to the file’s Fact Type List  

(3) The information is placed in the Fact’s Description field 

(a) Reminder: The Description field is recommended to contain no more than 100 

characters 

(b) You may decide to move most, or all, of the Life Sketch Description entry to the 

Fact’s Note. If you choose to do this to ensure no loss of data when exporting 

it, be aware that the FamilySearch Person Tool will show that the version in 

RootsMagic is different compared to the version at FamilySearch 

LDS FEATURES 

WEBTAGS 
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ENTERING INTERNATIONAL CHARACTERS 

GENERAL INFORMATION 

1. RootsMagic supports Unicode characters -  “Wikipedia: List of Unicode characters”  

EMOJIs 

1. Emojis are a unique character set that can be inserted like International Characters anywhere 

that text can be entered.  

2. However, Emojis are treated differently in RootsMagic: 

a. Emojis appear in RootsMagic Charts and Reports as blank spaces 

b. Emojis can be transferred via TreeShare to an Ancestry tree 

c. Saved searches that include Emojis do not work when re-used. RootsMagic Tech Support 

recommends not using them as search text  

d. Tech Support reports that some Emojis have been found to cause issues with some reports 

and may cause a GEDCOM export to fail 

3. It’s recommended that emojis not be inserted into a Person’s Given or Surname data field 

because they could affect the results received back from any WebHint or Online Site searches 

that include them. 

4. The operating system Emoji keyboard can be activated by pressing the “Windows 

key”+”.”(period) on Windows, or Ctrl+Cmd+Space on Mac computers. 

5. Another option is to find, copy & paste them from an emoji website, such as: “Getemoji”  

6. Once entered, they can’t be “turned on/off” for different activities. Therefore, careful 

consideration needs to be taken before deciding to add emojis into the database.  

a. If inserted in a Fact, inclusion of the Fact Type can be turned on/off by editing the “Include” 

settings for the Fact Type.  

b. If inserted in the “Reference No” Fact Type, they can be displayed after a Person’s name in 

place of the RIN (Record ID Number) or FSID (FamilySearch Identification) by changing the 

setting at: SETTINGS Page> GENERAL Settings View> “Number To Display” to “REFN” 

  

https://en.wikipedia.org/wiki/List_of_Unicode_characters
https://en.wikipedia.org/wiki/List_of_Unicode_characters
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KEYBOARD SHORTCUTS 

GENERAL INFORMATION 

1. Edit Person window: 

a. Alt+A (Option on Mac?) initiates the Add a Fact function when in the Edit Person window 

b. Alt+O (Option on Mac?) opens the Options popup window on the Edit Person window 

2. Data Field Navigation: 

a. Tab key when cursor is in a data field, it will highlight the next data field 

b. Right (Arrow) opens the currently highlighted data field 

3. RM11 & On, Ctrl+Shift+Left(Arrow) and Ctrl+Shift+Right(Arrow) (Cmd on Mac) selects text field 

and Note words one word to the left/right at a time 
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OTHER INFORMATION 

RESOLVING KNOWN PROBLEMS: 

1. If using a Mac and the “Unexpected Error Instance of “TabuImage” not created” error message 

appears, some users think it’s caused by the presence of unacceptable special characters in 1 or 

more Media Filenames and/or folder paths. However, RootsMagic has not been able to confirm 

this is the “real” cause of the issue and therefore do not have a guaranteed fix yet. To see if 

special characters are causing the issue, the steps to try and recover are: 

a. Perform steps to Force Quit RootsMagic 

b. Rename the database if it’s set up to open automatically when RootsMagic is started 

c. Start RootsMagic 

d. Open the renamed database  

e. Make a Backup File in case it’s necessary to revert back 

f. Optional, creating a Multimedia List Report may help in identifying and tracking which files 

require modification 

g. MEDIA Page > Any View > (RM11 & On) TOOLS/(Pre-RM11) MORE OPTIONS (3 dots) Icon> 

select Search and Replace 

h. Search the Multimedia Filenames in the database for the following special characters and 

replace them, one at a time: 

i. #, $, commas, double spaces, (, ), {, }, !, *, and any other unusual special character 

symbol, like a square box 

i. For each character found and replaced, perform the same to rename the Media Files using 

FINDER to highlight all names under the MEDIA directory: 

i. Choose RENAME from the FINDER File menu 

ii. Repeat finding and replacing each special character found in the database. 

2. If a database file is moved between Mac and Windows computers, there be an index 

compatibility issue on initial use. The problem can be rectified by running the “Rebuild Indexes” 

Database Tool, found on the TOOLS Page. 

TECHNICAL INFORMATION:  

1. User Settings File: 

a. RootsMagicUser.xml – Each time RootsMagic is closed, all program-level setting information 

is written to this file for use the next time RootsMagic is started. The information includes: 

User set options, window sizes, screen divider bar position information and lists of recently 

used files & folders.  

b. Location:  

i. On a Windows PC, the file is located in the “Users > "yourusername” >  AppData > 

Roaming > RootsMagic > Version “#” folder. Note that the AppData folder is hidden.  

ii. On a Mac, a search of the hard drive should locate this filename. 

c. This xml file can be viewed (but not edited) in any web browser.  

d. If for some reason you desire to edit the data, open the file in any text/word processor 

software. However, the file does not contain sufficient formatting information for these 

programs to present the information in an easy-to-read format. It’s recommended to open 
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the file in a web browser for easy reading and location of specific data to be changed and a 

text editor to search for and edit the desired text without altering the xml coding. 

e. All of your settings can be replicated onto another computer running the same version of 

RootsMagic by placing a copy of this file in the correct location prior to opening RootsMagic. 

PROBLEM SOLVING INFORMATION: 

1. Learning how a feature or tool works:  

a. The first step to learning about any new tool is to play with it along with your ideas for using 

it in a Test Database file to make sure you understand everything works before using it with 

the main research database. 

b. There are 2 different ways to approach creating Test Databases: 

i. Create a small database, by Drag & Dropping a couple of generations of the main 

database into a new, empty, file. Use the small database to test and learn how a tool 

works, or doesn’t. 

(1) FILE Page > CREATE A NEW ROOTSMAGIC FILE > EMPTY FILE 

ii. Or, just make a copy of the entire database and give it a new name that clearly identifies 

it as a Test Database: 

(1) FILE Page > TOOLS > COPY 

(2) Decide where to save it 

(3) Give it a name that makes it clear it’s the Test Database and not the Main Research 

Database  

(4) Save the file 

(5) Make a Backup of the Test Database file so that it can be Restored whenever it’s 

necessary to reset the Test Database during testing  

c. Play with the tool and how it behaves using the Test Database first. Confirm your 

understanding of how it works. Additional sources of help are listed in the “Getting Started – 

General Information section”  

i. Links in the Help and Support Section on the software program’s HOME Page 

ii. The RootsMagic Community, which is viewable by the public, even without an account. 

An account is required, if you want to post or keep track of which postings have read 

and which are new. 

iii. At our monthly SIG meetings, Open Q&A and SIG email (rootsmagic@gfo.org) 

iv. If you’re a member of the Private RootsMagic Users Facebook Group administered by 

RootsMagic, there’s always a lot of posts about new features recently added to the 

program and questions about how to do things 

2. Complicated Searches and Filtering: 

a. RM11 & On, When performing complicated Searches and Filters, use the Enhanced Rules-

Based Advanced Search and/or Group capability.  

i. Instead of using the Mark/Unmark filtering “By Data Fields” option in the ROOTSMAGIC 

EXPLORER Window, use the “Saved Searches” option to take advantage of the Enhanced 

Rules-Based Advanced Search which supports the creation of complicated Searches   

b. Pre-RM11, Using the Rules-Based Search Criteria Window or the RootsMagic Explorer 

Mark/Unmark using Data Fields to create Boolean Logic filters is one of the more powerful 
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tools in RootsMagic in terms of being able to find People that meet a specific set of criteria 

for a task or problem. 

i. But it can appear difficult to use if attempting to write and apply a series of conditions 

all at once and are surprised the resulting list of People isn’t what was expected 

ii. The effect of using both the AND & OR connectors in the same filter criteria can 

sometimes create unexpected results 

iii. Understanding what the filter field criteria are actually looking at is important 

iv. Working out the complicated filters incrementally as a series of simpler, shorter, filters 

is a good technique to avoid some frustration and will usually help point to where things 

may not work as expected 

3. Resolving “linking issues”  

a. Linking issues typically appear in one or more of the following forms:  

i. Duplicate People with same RIN (Record ID Number) 

ii. Children from same Family not linked to the same Parental Couple 

iii. Known Spouses shown as “Unknown Spouse” in the Descendant View. 

b. If it’s determined the original cause was from data brought into the database file via the 

Ancestry TreeShare or the FamilySearch tool, it’s recommended the issue get fixed at those 

sites and bring the changes into the file rather than fix it in RootsMagic and attempt to push 

the fix back to the Online Site that introduced the original problem. 

c. Most linking issues can be analyzed and corrected by performing the following steps in the 

order listed: 

i. Run the 4 Database Tools found on the TOOLS Page to ensure there are no internal 

database issues 

ii. If not already displayed, turn on the display of each Person’s RIN: 

(1) SETTINGS Page> GENERAL Settings View > “Number To Display” = RIN 

iii. The same Person, with different RINs (Record ID Numbers), are duplicated People in 

the database that should be Manually Merged and then the merged information can 

be cleaned up 

(1) PEOPLE Page > Any View > TOOLS > “Manual Merge” 

iv. Select the Person of Interest, then switch to the DESCENDANT View and set the 

number of generations to display to “2” 

(1) There are 2 types of relationship links:  

(a) Parents (a Couple) to a Child 

(b) Spouse to Spouse.  

v. Analyze each “Family” currently defined in the database for this Person. Determine 

which People are shown in incorrect “Families.” Look for these symptoms: 

(1) Is the same Couple listed more than once? If yes: 

(a) Potential Cause: Open the Person’s EDIT PERSON Window and look for 

multiple Marriage Facts for the same Couple.  

(b) Solution: If Couple only married once, merge Marriage Fact data into a single 

Marriage Fact. If Couple did get married more than once, take no action. 

(2) Is the same Child appearing under more than one Couple (Person and “Unknown 

Spouse” and/or Person and same Spouse)? If yes: 

(a) Cause: Child linked to more than 1 set of Parents 
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(b) Solution: Unlink incorrect Parents from Child 

(3) Some Children listed under one Couple entry and other Children born to the same 

Parents listed under a different Couple entry 

(a) Cause: Children were not linked to the same Couple (possibly the result of 

using the “+ Add Father/Mother” Buttons instead of “Add Parents” on the 

PEDIGREE View) 

(b) Solution: Link all Children to the same Couple in the database and Unlink them 

from the other sets of Parents (User preference whether to Link/Unlink or 

Unlink/Link). 

(4) Couples you didn’t expect to see, including having an “Unknown Spouse” and no 

Children 

(a) Cause: Either incorrect Spouse link applied, or a Child was previously linked, 

and subsequently unlinked 

(b) Solution: Unlink from Spouse 

vi. Once the People and relationships needing correction have been determined, select 

one of the Parents and switch to the Family View to ensure both you and RootsMagic 

are focused on the same Family relationships before performing the appropriate 

solution: 

(1) Link/Unlink relationships in this Family as necessary.  

(2) Reminder: The “Unlink Family Members” choice can be used when it’s desired to 

unlink all Children from their Parents and unlink the Parents from each other for 

the Family displayed in the Family View 

vii. Repeat, starting at step iv, until all bad links have been corrected and the Family is 

properly depicted in the Descendant View. 

(1) If there’s a multi-generational issue, shift the Descendant View 1 generation 

up/down to analyze and correct bad links one Family at a time. 

UPGRADING FROM EARLIER VERSIONS OF ROOTSMAGIC: 

1. Upgrading from a Pre-RM8 version: 

a. Contact the GFO RootsMagic SIG facilitator (rootsmagic@gfo.org) for current 

recommendations 

2. Upgrading from an RM8 & On version: 

a. Review the following before proceeding with the actual installation and conversion process: 

i. Each version of RootsMagic installs as a separate software program on the computer.  

ii. The installation program will ask whether the older version should be uninstalled as 

part of the installation process. You can: 

Note: Leaving the older version installed, at least until the new version is set up, 

makes it easier to ensure the Settings entered on the SETTINGS Page in the older 

version are properly transferred to the new version (they’re not automatically 

transferred by the installation software)  

(1) Let the software uninstall the older version while installing the latest version.  

(2) Leave the older version installed for now and use the Operating System Uninstall 

Program capability to remove the older version later 

mailto:rootsmagic@gfo.org
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(3) Keep the older version installed 

iii. When an RM8 & On database file is opened for the first time in a newer version, the 

file is “converted” to be compatible with the new version  

1. Once a file is “converted”, it can no longer be opened using the older version  

2. If the capability to continue using a database file with the older version is desired, 

a copy of the older database file must be made and renamed to clearly identify 

the version it’s intended to be used with and/or place it in a different folder 

before proceeding with the “conversion” of one of the 2 copies of the file  

3. Otherwise, make a Backup of the old version file before proceeding. Edit the 

Backup Filename to indicate it was the last Backup prior to converting to the 

newer version 

b. Install the RootsMagic program, but do not open any files yet 

c. Open the new version and go to the SETTINGS Page.  

Note: If the older version was not uninstalled, open it and go to it’s SETTINGS Page 

in order to view the settings in the older version while setting up the new version 

i. At a minimum, on the FOLDERS Settings View, set the “Data Folder” to point to where 

the database files for the new version (and the file to be “converted”) is located.  

ii. Normally, these Settings would be the same folder locations as the older version with 

the exception of the Data Folder, if you’ve decided to place the “converted” database 

file in a different folder than the old database file 

d. Now open the database file to be “converted” to use with the new version  

e. Return to the SETTINGS Page and set the remaining Settings for each View to the desired 

settings  

i. If the older version is still installed, open it and manually transfer the Settings in the 

older version to the new version, ensuring the new version looks and behaves similar 

to the older version  

f. Once the Settings have been transferred, if the older version is no longer desired to be 

installed, use the Operating System program uninstall function to remove the older version 

g. Windows Only, During the installation of a new version, if you elected to have RootsMagic 

uninstall the older version, some Users get a message while using the program that the 

Place Database is “Missing”. To reinstall the Place Database:  

i. Select the version you are using on the RootsMagic Downloads webpage 

ii. Click on the “Show Other Downloads” link below the blue Download Button 

iii. Under “Optional Downloads,” select “Placve Database Installer” 

iv. After it downloads, install it 

https://www.rootsmagic.com/download/rootsmagic

